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Welcome to Notes •n• Files! 

You might be interested in knowing how Notes •n• Files came about. We 

surveyed many people, most of them new to computers, by asking them what 

programs they would like to see on their new Apple ][ GS. The most common 

answer was the following: 

"I'd like to be able to keep track of some names and addresses and 

write these people a letter now and then, or maybe just jot down a 

memo and file it away ... " 

It seems like they are saying they want to do what they already do at home or 

i.n their office! They get a manila folder, take a marks-·a-lot and write a name or 

title on the cover, then they "stuff" the insides of this folder with letters , notes , 

memos, even phone numbers jotted down on scraps of paper. Isn't this what you 

do, too? Wouldn't it be great to have your Apple J( GS do it for you? 

Well, this is exactly what Notes •n• Files can do! You type your letters and 

notes right on the screen and then you can actually put your documents 

inside little file folders . These folders can then be filed away inside the drawers 

of a life-like file cabinet, just the way you are already know how to do! You see, 

it isn't going to be very hard at all to learn how to use Notes •n• Files. 

Because Notes •n• Files is based upon YOUR requests, we would like to 

think that YOU had something to do with its creation! So, write us a letter and tell 

us what you think. Don't forget to fill out your Registration/Warranty Card and 

mail it to DataPak. This will entitle you to use Tech Support Services, and you will 

receive a backup disk of Notes •n• Files at no extra charge! 



CUSTOMER LICENSE AGREEMENT 

l_mportant: Read this license agreement carefully before operating th is package . The enclosed software is 

licensed to customers for their use only on the condition that they agree to the terms set forth below . 

1. SOFTWARE: This license ag'.eement applies to the Software enclosed in this package, including the 

computer program materia l on the disk media and any of the associated documentation. 

2. COPYRIGHT : The enclosed software and its documentation have been copyrighted. The customer may not 

copy or otherwise reproduce any part of the program except for that which is nece ssarily called for in the 

operation of the program . 

3. LICENSE : DataPak Software, Inc. hereby grants to the customer a non-exclusive license to use the 

enclosed software subject to the terms and restrictions below. 

4. RESTRICTIONS ON USE : The original and any backup copies of the software and Its documentation may 

be used with only the registered owner. 

5. RESTRICTIONS ON TRANSFERS : The original and backup copies of the software and documenta tion 

may be sold, assigned, given or otherwise transferred to another, provided the transferee agrees to the terms 

and condi tions of this agreement and completes and return s a product registration card. Upon transfer, you. the 
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6. TERM : This license is in effect until terminated. You, the customer, may terminate this license at any time by 

destroying all the software, including backups, and its documentation . DataPak Software, Inc. may also term inate 

this license if you fail to comply with any term or condition of the license agreem ent. You agree that upon 

termination by DataPak Software, Inc. to destroy all the software, including backups, and its documen tation in 

your possession. 
7. PERFORMANCE WARRANTY : DATAPAK SO FTWARE , INC . ITS SUPPLIERS, DEALERS AND 

DISTRIBUTORS, MAKE NO WARRANTIES, EITHER EXPRESSED OR IMPLIED . WITH RESPECT TO THE 

PERFORMANCE OF THIS SOFTWARE OR THE RESULTS OBTAINABLE THEREBY. ACCORDINGLY , THE 

SOF TWARE IS LICENSED "AS JS", AND THUS THE ENTIRE RISK AS TO ITS PERFORMANCE JS WITH THE 

CUSTOM ER. 
8. LIMITATION OF LIABILITY : NEITHER DATAPAK SOFTWARE. INC ., ITS SUPPLIERS , DEALERS OR 

DISTRIBUTORS. SHALL BE LIABLE FOR ANY DIRECT, INCIDENTAL OR CONSEQUENTIAL DAMA GES 

RESULTING FROM ANY DEFECT IN THE SOFTWAR E. EVEN IF THE Y HAVE BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 

DIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES . SO THE ABOVE LIMITATION MAY NOT APPLY TO 

YOU. 
9. Your use of the softwa re program acknowledges that you have read and agree to this customer license 

agreement. 

WA RRANTY : 
1. DISKETTE WARRANTY: DataPak Software, Inc. warrants the diskette to be free of defects for a period or 

ninety (90) days from the date of purchase as evidenced by your receipt. Thi s w arranty is not tran sferable. 

applying only to the original custome r. 

2. DISKETTE REPLA CEM ENT : In the event that the software diskette proves to be defective, DataPak 

Software. Inc. will replace the diskette free of charge for a period of ninety (90) days . To order a replacement 

diskelle, you must include the product registration card, only if you have not previously registered, and the 

defective diskette . 
3. PRODUCT REGISTRATION : Completing the Product Regist ration card enables you to take advantage of 

Customer Support Services . 
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1.0 GETTING STARTED 

About the Manual 
This manual has been written in a way that makes it easy for anyone to learn 

how to use Notes •n• Files. There are lots of pictures and helpful "tips" 
designed to get you thinking and intended to allow you to learn the program at 
~ own pace, step-by-step, gradually increasing your knowledge of the 
program and building upon your ability to apply what you learn. 

Each chapter is presented upon a gradient scale of learning difficulty. A 
chapter usually begins with a "walk-through" to nurse along the very beginner 
and prevents one from becoming drowned with complexities. After this, the 
chapter picks up the pace by giving you more detailed explanations of how a 
certain area of the program works. The chapter ends with advanced solutions for 
the creative user who wants to apply Notes •n• Files to its utmost capacity. 

How to Study 
Always study at a level that best suits your own particular learning abilities. 

You can "pick and choose" which parts of the program you want to learn about 
and use. You don't need to learn everything at once. There are priorities to 
consider . It is entirely up to you to decide which parts of the program are 
important to you today and which ones you could skip over and study 
tomorrow. The Index at the back of this manual is ideal for finding specific 
sections of the program that you wish to study. 

When you study. you should set your sights on a particular goal for the day, 
such as "today I'm going to learn how to print documents", then study that 
area alone. Don't wander off into parts of the program you have no use for just 
yet. You will find that if you have simple "wins" using the program from the very 
start, then your progress with Notes •n• Files will advance much faster than if 
you vainly take a stab at trying to become a full expert in just one short session. 

Slowly but surely build your knowledge and abilities, but above all, have fun 

while doing it! 

Tech Support · 
If you find you are having any trouble with Notes •n• Files, then you may 

want to call our Tech Support crew for assistance. Before you call, always 
ensure you have your computer setup and running (near your telephone, if 
possible) with your instructions manual in hand and a list of questions written 
down. In this way, the Tech Support team can help you much better and faster. 

The Technical Support Division at DataPak is open to the public 
between 10:00 am and 5:00 pm PST. Call (818) 905-2201. 
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1.1 What You Need to Start 

rn~~~mo 
NOTE: If you are a beginner, you don't really have to read this next section. If 

you want you can go on ahead to "1.2 Booting Up" on page 5 and then come 
back here later on. If you have any trouble getting started, then by all means 
return to read this section as it might answer some of your questions. 

Recommended System: 
1) Apple ][ GS with 512k memory. 
2) Two 3 1/2" disk drives . 
3) lmageWriter II printer. 
4) 8 1/2" by 11" form-feed printer paper 
5) 2 1 /2" by 15/16", three across labels. 

Your particular setup depends strictly upon your own personal needs. Here is 
an expanded list of the recommended System: 

1) You need, of course, an Apple ][ GS to use Notes •n• Files for it 
doesn't run on any other computer. However, to run .any major program on your 
GS you will need to have at least 512k of memory . 

The technical reason for this is that any major program, such as Notes •n• 
Files , will require plenty of internal space in order to manage the comp lex 
colored graphics as well as being able to handle the extra memory space 
requested when you type a fairly large document. Therefore , if you ~ have a 
256k GS, then you will be "begging for trouble" because you will frequently run 
out of memory and be unable to do the things you want to do. Memory board 
expansion kits can be obtained from your local Apple dealer. 

2) You will need a disk drive . This is obviously required because your 
computer needs it in order to read the data from a diskette or to write new data. 
Preferably, you should have a 3 1/2" drive since they use double-sided disks 
capable of having much more storage capacity than the 5 1 /4" floppy disks. 
Notes •n• Files itself must reside and operate on a 3 1 /2" diskette, but you may 
use your 5 1/4" disks for data only, although the disk space available would be 
very limiting. 

Having 2 drives isn't essential, but is highly recommended . One drive can 
hold the program, Notes •n• Files, with the second drive dedicated for disks 
containing data only. You can quickly fill up a disk using a single drive and will 
eventually need to use a second disk. 
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When Y<?U fill up yo_ur first disk and you want to save more files, then without a 
second drive you will have to stop and switch back and forth between the 
second dis~ and the first disk. For this reason you may want to eventually expand 
to a hard disk . It can hold many times more data than ordinary disks accessing 
Y?Ur data is accomplished much faster and you won't have to always "swap" 
disks back and forth . If you intend to have many 1 OOO's of records (folders and 
documents), you will eventually need to have a hard disk or else you won't be 
able to fit all of your records on just one diskette . (See "Notes •n• Files: 
Technical Info" on page 4 for installing the program on your hard disk). 

3) You will need a diskette. You can use the master diskette (the one 
containing Notes •n• Files), but don't forget you will probably fill this disk up 
with data fairly rapidly . For this reason, you should obtain a few extra disks 
(available from your local Apple dealer), and pre-format them using the Apple][ 
GS System Utilities Disk that came with your computer. 

Notes •n• Files will be unable to recognize an unformatted data disk. If you 
want you can initialize a few disks and have them ready for use. You will be able 
to create multiple cabinets on them that can be used for varying subjects, such 
as a cabinet for business clients, another for personal matters, and so forth. 
Perhaps you will want an individual data disk for each subject. This is entirely up 
to you. 

4) You'll want to have a good printer. It isn't mandatory to have a printer, but 
you will need one, of course, if you want to print the letters you type, along with 
their mailing labels, or to print listings of your names and addresses. If you want 
to print in different fonts and styles, then you will need an lmageWriter printer . 
The lmageWriter is a dot-matrix printer which means it prints characters in the 
form of tiny "dots". It can therefore print graphic pictures or characters of varying 
sizes . If you want to have letter quality printing , you might want to obtain a 
Daisy-wheel type printer. It uses a wheel comprised of a "molded" character set 
that strikes the ribbon producing a sharp print, much like a typewriter. However, a 
Daisy-wheel is jncapable of printing the different fonts available with Notes •n• 
Files. It you desire ultra-fine resolution printing, then you'll want the more 
expensive LaserWriter which can produce book or magazine quality print. 

5) You will want to have some printer paper . This. can be the standard 8 
1 /2" by 11" pin-feed paper , or you can use your single sheet , letterhead 
stationery and manually feed the paper into your printer. The recommended size 
for mailing labels is 2 1/2" by 15/16", three labels across ea~h roll!, but yo':' may 
also use fancier and larger, one across labels. Notes •n• Files will also print on 
Legal size paper (8 1/2" by 14"), Computer paper (15" wide) or Index card size (3" 
by 5") . Note: You must have a ~ide lmageWriter to p~in_t 15" acro_ss. Also, the 
lmageWriter cannot handle thick index cards due to friction and slippage . As a 
solution you may need to obtain a special "tractor" to feed your cards, or use a 
different printer altogether. 
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Notes •n• Files: Technical Info 

If you don't reach the MAIN SCREEN (as shown on page 7), then you will 
need to read the following section . Something has obviously gone "wrong". This 
can be the result of various factors. A list of possible remedies is given below: 

1) A message on the screen says "Check startup device" . This happens 
when there is either !lQ disk inserted into the disk drive or the disk is not a 
startup disk. There could also be something physically wrong with the disk or 
the drive . Try again , and if the disk still fails to boot, consult your local Apple 
dealer or call DataPak Tech Support. 

2) The disk ejects from the drive upon startup. On rare occasions, a disk 
inserted for the first time may in fact be rejected by the computer during the 
boot-up process. In this case, immediately re-insert the disk and try again. 

3) The Program Launcher appears, but Notes •n• Files fails to come on 
the screen when "launched". This commonly occurs because of an incorrect 
RAM setting. You will need to check the Control Panel (press the 3 keys 
OPEN-APPLE CONTROL and ESCAPE simultaneous ly) and then ensure that 

the RAM Disk is not set too large so as to interfere with the amount of internal 
memory available. Make it Ok (zero) if possible (using the arrows, then pressing 
RETURN). If you do change the RAM size, you must Quit the Control Panel 
and re-boot the computer by turning it off then on. Also , while in the Control 
Panel , you may want to perform other tasks such as setting the clock, selecting 
the desired keyboard and mouse speeds , verifying printer defaults, etc., or you 
can toy around with these settings later on. Consult your GS Manual for more 
detailed instructions on using the Control Panel. 

4) RAM is correctly set, but Notes •n• Files still fails to run. This would then 
mean something is wrong with the disk itself, or you are attempting to run a 
COPY of the program (or the hard disk install was never performed - see #6). 

5) Notes •n• Files is copy-protected. If you make a copy of the program 
(or attempt to run it from a RAM disk) it will .o.Q1 run. Copying from a hard disk 
back down to a floppy will also fail. A fully working backup disk of Notes •n• 
Files is available to registered owners at no additional charge. 

6) If you will be using a hard disk , the program "HD.INST ALL" (found in the 
PROGRAMS FOLDER) can be selected and run in order to install Notes •n· 
Files on your hard disk, thereafter allowing you to run the program witho!.!1 

having to use the master diskette. 

7) The "START" program (which is really the "Program Launcher" ), can be 
renamed or even deleted (using your System Utilities Disk) and then you can 
rename "NOTES.N.FILES" to "START", in which case Notes •n• Files will 

always boot directly and come up first. 

4 



1.2 Booting-Up 

[oJ 
NOTE: The following "walk-through" is included for those of you who are new 

to computers and need some extra help. You advanced wizards can jump ahead 
at your own risk by running "NOTES.N.FILES" from the PROGRAMS 
FOLDER and then move on to "2.0 THE FILE CABINET", page 9. 

How to Start Notes •n• Files 
You realize, of course, a computer cannot ever work all by itself. It needs a 

program (a set of instructions) that orders it to do things . Thus, you first have to 

turn on the computer with your Notes •n• Files diskette sitting inside the disk 

drive. (This disk is called a STARTUP disk) . The very first program that will 

come up on the screen is called the Program Launcher. It gives you a list of 

other available programs that you can select and RUN. You will use this 

Program Launcher to find and run Notes •n• Files. 

STEP 1 : Remove any diskettes you might be currently using and turn your 

GS off. Insert the Notes •n• Files master diskette into your disk drive and 

turn your GS on. In a few moments you will see the Program Launcher: 

Select the file you want to open: 
[8) /NF .MRSTER/ 

().-. PflODOS 
D PROGRAMS 
D SAMPLES 
D SYSTEM 

Q Disk 

[( Open )] 

Clos e~ 

(Note: The above Program Launcher is from Apple Computer, Inc.). 
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The Pointer 
The very first thing to learn about is called the ARROW POINTER . When 

you move the MOUSE on your table, the POINTER will likewise change its 

position on the screen. 

The POINTER is used, as you can guess, to "point to" various items on the 

screen that you would like to select and do something with. 

STEP 2: By "rolling" the mouse on your table, position the ARROW so that it 

is directly on the name "PROGRAMS", PRESS DOWN on the mouse button 

and then let it up. This is called "CLICKING THE MOUSE". You will see the 

name "PROGRAMS" become HIGHLIGHTED as shown in the follo wing 

picture: 

Select the file you want to open: 

[o) / NF .MASTER/ 

. <£;.~ Pfl(HIOS · f ...... .... t'l:1·,.~ .. 

D SAMPLES ' 
D SYSTEM 

u 

Disk 

[[ Open )) 

Clo s<~ 

Quit . 

STEP 3: Move the ARROW POINTER over to the "Open" button and again 

CLICK THE MOUSE: 

.[( Open ~J 
The screen will change to the following picture : 
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Select the file you want to open: 

s:5J / NF.MRSTER/PROGRRMS/ 

~ HD. I NSTRLL 0 
!::1 Nf'.D[SKrDP 

L1 NrJISflC 
I 

[1 PHKSON"fS 

0 

Disk 

[[ Open ~J 
Close l 

Quit 

STEP 4: Now, do the same steps again, but this time CLICK on the name 

"NOTES.N.FILES" (this is the program!) then CLICK on the "Open" button, as 

shown above . This will "launch" your Notes •n• Files. In a few moments you 

will be inside the program and see the following screen: 

The Notes •n Files main screen. 
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1.3 Inside Notes •n• Files 

Once inside Notes •n• Files you can easily recognize the File Cabinet. 
Along the top of the screen are what we call pull-down MENUS and along the 
bottom of the screen are some "tools" that we shall learn about later on. 

Menus 
The MENUS allow you to .choose from a variety of functions that tell Notes 

•n• Files what you would like to do next. Move the POINTER up to the top left 

corner of the screen so that it is directly on the Apple • character: 

Lg File Edit 

lillillf~:,;,:,;,;;;L,,,,,;,,,,,,,,,,,,,,,:;;,I 

Moving the mouse, of course, does nothing all by itself except move the 

POINTER about the screen. In order to then choose or do something you need 

to. PRESS AND HOLD DOWN the mouse button. Do so right now and notice 

how the MENU "drops down" and comes to view. Slowly move the POINTER 

DOWNWARDS (keeping the button depressed) across the "items" of the 

MENU: 

As the POINTER passes over an item, that item becomes HIGHLIGHTED 

(selectable). When the POINTER hovers over an item, and you release the 

mouse button, Notes •n• Files will then perform whatever task the MENU 

ITEM TELLS IT TO DO. Go ahead and select "About Notes •n• Files" and 

you will be shown a little window telling you some information about the program 

(and the version number of your disk). When done, click within the "OK" button 

and the little window will disappear. 

Believe it or not, this is about as complex as Notes •n• Flies should ever 

get I 
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2.0 THE FILE CABINET 

NOTE: The following "walk-through" is intended for beginners only. Advanced 
users can continue on with "2.1 Creating a New Cabinet", page 12. 

The FILE CABINET behaves just like a real-life cabinet. A Drawer can be 

opened up to display your Folders. Inside these Folders you can store your 

Letters and Notes. So, you see it's naturally going to be easy to learn how to 

use Notes •n• Files. 

We will be using the "Sample.Files" CABINET for our "walk-through". This 

CABINET is nothing more than an example CABINET provided for you by 

DataPak . It merely demonstrates some of the things you can do with Notes •n• 

Files and you will learn later on how to create your own new CABINETS! The 

top DRAWER of the "Sample.Files" CABINET already has some FOLDERS 

inside. We shall use this top DRAWER from time to time for our "walk-through". 

The bottom DRAWER is completely empty and you can use it for your own 

tests as you study along . 

Opening a Drawer 
Place the POINTER anywhere on the top Drawer rectangl e, as shown 

below, and then press the mouse button down TWICE in fairly rapid succession. 

This is called DOUBLE-CLICKING the mouse: 
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The Drawer will magically "pop" open to display the sample FOLDERS: 

Notice how the FOLDERS fan out in alphabetical order. You see it will be 

a breeze to find the ones you want to work with. 

Closing a Drawer 
In order to use the bottom DRAWER you first have to CLOSE the top 

DRAWER. This is done by clicking in the little white rectangle at the upper left 

corner of the DRAWER , as shown in the picture below, and the DRAWER will 

CLOSE shut: 

Now, OPEN the bottom "Untitled" DRAWER so you can follow along. 

Renaming a Drawer 
Whenever a Drawer is OPEN you can change its TITLE by selecting 

"Rename Drawer" from the Edit menu. Note that this item on the menu 

becomes ACTIVE (selectable) only when a DRAWER is in fact OPEN . 

10 



As you know, you place the pointer on the word "Edit" at the top of the screen, 

click the mouse and while holding down the button you move the pointer 

downwards until "Rename Drawer" becomes HIGHLIGHTED, as shown in 

the following picture: -~ ... -
Undo 

Cut 
COP!J ~~ C 
Pust<~ d ll 
fhmtHn<~ folder fields ~! fl 
Rename Drawer , ..:-, D 

Upon letting go of the mouse button, you will be presented with the following 

window: 

Re-nome opened Drawer: 

jMy Drowerl 

[[]DJ [ Cancel ] 

Type in a new TITLE for your DRAWER, such as "My Drawer" shown 

above, and when ready click on the "OK" button or press the RETURN key. 

Because there is a "ring" around the button it is the DEFAULT selection. 

Pressing RETURN is the same as clicking in it. If you click the "Cancel" button, 

you will return back to your CABINET with the DRAWER'S NAME unaltered. 

You can name the DRAWERS anything you'd like. Some examples would be 

"Clients" or "Friends", and so on. You would then make a File Folder for~ 

person. Or, you might like to "split" the CABINET alphabetically in half by using 

"A-M" for the top DRAWER and "N-Z" for the bottom . You can even call the 

DRAWER "Poetry" or "Bills". You can then create Folders and put 

Documents in them containing your poetry, or a typed list of bills, a schedule or 

your formal business letters and reports, you see, but you don't have to use a 

CABINET to hold just names and addresses! 
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2.1 Creating a New Cabinet 

NOTE: Beginners should move straight to "3.0 FILE FOLDERS" on page 
18 and come back to this section when the need arises to create a NEW 
CABINET. 

You can only work with one CABINET at a time, but you can keep multiple 

CABINETS on the same disk and go back and forth between them, or you can 

use multiple disks to store your CABINETS. You can create as many 

CABINETS as a disk can hold (which depends on various factors covered later). 

In order to create a brand new CABINET , you first have to put away the one 

you are currently working with by choosing "Close Cabinet" from the File menu 

and the screen will be cleared . At this point, go back up to the File menu and 

select "New Cabinet": 

You will then be presented with the following window : 

"5J /Nf.Master/Samples/ 
Free: 400k out of 800k. 

Disk 

L~ S1Hnplc1.nlHs 
L~ Snmp1<1.nl<~s.H 
fJ Snmpl<~.rn<~s .B 

.fr [New Folder) 

Close 

Saue )] 

Cancel J 

Make a Cabinet called: [( 

.__!mtn_· __ __.I [ 

(Your window may look different than the above SAMPLES FOLDER). 
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Disk Folders 
While the above window looks complex at first, it's actually very simple. It is 

asking you for the DESTINATION of where you would like to create a NEW 

CABINET on your DISK. 

A DISK is divided into individual sections which are called FOLDERS . (Note : 

This has nothing to do with the Folders in your File Cabinet!). Each FOLDER 

can hold separate files (and/or programs) which are "isolated " from all other 

FOLDERS. Therefore, you can think of a DISK as really being made-up of alot 

of little mini-disks . 

The DESTINATION for your CABINET will be QD..e. of these FOLDERS. 

Closing a Folder 
You may have noticed in the previous picture that you are in the "SAMPLES" 

FOLDER on your disk . In fact, the "Sample .Files" CABINET exists inside this 

FOLDER . If you click on the "Close" button you will see the window change and 

show you a list of your other available FOLDERS : 

<J.~ PHOBOS 
D PROGRRMS 
D SRMPLES 
D SYSTEM 

Making a New Folder 
To create a new FOLDER (you don't have to unless you want to), start typing 

a NAME at the bottom of the window, such as "My.Folder". (You can use 

periods, but not spaces) : I My.Folder! 

When finished typing the name, click on the "New Folder" button: 

~ Fold er) 
~ 

You have now made a FOLDER for the CABINET you are about to create. 
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The reason why you would want to make a FOLDER at all is so that you can 

set aside your CABINETS by SUBJECT. For example, you could create a 

FOLDER called "Clients" and keep CABINETS in that FOLDER dedicated to 

people with whom you do business , or create another FOLDER just for your 

"Personal" type CABINETS, and so on. 

Using a Different Disk 
You can change the DESTINATION to an entirely different disk by first 

manually ejecting the current disk (unless , of course, you are using 2 drives), 

inserting another disk and then clicking on the "Disk" button. Note that the 

NAME of the currently selected disk will always appear at the top of the window. 

LJITP 
Selecting a Folder 

When selecting a DESTINATION for your NEW CABINET you can choose 

either an existing FOLDER or create a new one. Let's CHOOSE the FOLDER 

we just created: 

(J.-. PHO"IIOS 
D PROGRAMS 
D SAMPLES 
D SYSTEM 

Click once on the name "My.Folder", so that it becomes HIGHLIGHTED , 

and then click on the "Open" button, or press RETURN or just DOUBLE­

CLICK on the NAME. (Note that the UP or DOWN ARROW keys may be used 

instead of the mouse to select a FOLDER or CABINET). By doing so, THIS 

FOLDER will then become the CURRENT DESTINATION for the CABINET. 

The Destination Folder 
When you OPEN a FOLDER , or create a new one, its NAME will appear at 

the top of the window : a /Nf.Master/My.Folder/ 
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Notic e the little "open folder" icon . This means you are INSIDE THAT 

FOLDER and that it is the CURRENT DESTINATION. By the way, each "/" 

(slash character) within the NAME represents another FOLDER. Thus, you can 

have FOLDERS WITHIN FOLDERS WITHIN FOLDERS. 

You see that you can pin-point the desired DESTINATION FOLDER by 

"scanning" through your FOLDERS, OPENING or CLOSING them until you 

locate the right one. You can then proceed to create a CABINET inside the 

SELECTED DESTINATION FOLDER. 

Saving the New Cabinet 
To finally create the CABINET, you again type in a NAME at the bottom of 

the window. Backspace out the characters in the "edit box" and begin typing in a 

new NAME: 
Make a Cabinet called: 

I My.Cabinet! 

This time , when ready, click on the "Save" button, or press the RETURN key: 

[ Sauµ) 
If you enter the~ NAME as a CABINET that already exists in this 

FOLDER, you will be asked if it's alright to replace it. A new CABINET will then 

be created inside your DESTINATION FOLDER ("My.Folder") a,1d you will 

then be able to work with this NEW CABINET. 

Time-Out 
When you see the WATCH on the screen , it means Notes •n• Files is 

currently BUSY: 

All you need do is sit and wait until the ARROW pointer returns. This will 

happen during any lengthy process such as creating a new CABINET . 
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2.2 Opening a Cabinet 

To OPEN a previously created CABINET, go up to the File menu, select 

"Close Cabinet" and then go back up to the File menu and select "Open 

Cabinet": 

Upon doing so, a new window will appear. You locate your CABINET by 

OPENING or CLOSING your FOLDERS, or you can even get a CABINET 

that exists on another DISK, in which case you already know how to use the 

"Disk" button. 

When you have located your CABINET, click on its NAME, and then either 

click on the "Open" button or press RETURN. You may instead simply 

DOUBLE -CLICK upon the NAME: 

Open File Cabinet: 

<S /Nf.Master/My.Folder/ 

~ My.Cabinet , ffl Disk 

[( Open ]] 

Close 

~------ -- -~.O,~ Cancel 

The CHOSEN CABINET will then appear on the main screen where you 

can begin working with it. 
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Quitting Notes •n• Files 
When you select "Quit" from the File menu and exit Notes •n• Files for the 

day, you will return back to the original PROGRAM LAUNCHER (or some 

other type of "Finder" you may have STARTED with). You may then choose to 

run another GS program. But, it should be pointed out that you need to actually 

"Quit" Notes •n• Files because this will Save various PARAMETERS that 

you may have SET such as for the COPIER or LABELS, etc. (The file is called 

"NF.DESKTOP"). If you TURN OFF your GS instead of QUITTING (QI if your 

disk is locked ), then the PARAMETERS will .o.Q1 be Saved and will revert to 

their original SETTINGS when you use the program tomorrow. 

Also, the NAME of the CABINET you were last working with will be 

conveniently Saved . When you run the program tomorrow, Notes •n• Files will 

then attempt to re-open that same CABINET . However, if the CABINET cannot 

be found (it could be on some other data disk across your room), then you will 

immediately be given the "Open " window (shown in the previous picture) and 

you may continue by either locating and selecting the desired CABINET or by 

clicking "Cancel" and creating a NEW CABINET. 

About the Cabinet Files 
As a technical note, a FILE CABINET created on your disk is actually 

comprised of 3 separate files . For example, when you create a CABINET 

named "My.File", 2 more files are automatically created and are named 

"My.File.A" and "My.File.B" . Because there is a limit of up to 15 characters for 

any filename, and Notes •n• Files will "tag" 2 more characters to the ends of 

the extra files, a CABINET TITLE can only be 13 characters in length. 

The 2 extra files contain the INDEXES and are vital to the operation of a 

CABINET. Therefore, if you are going to COPY a CABINET to another disk (or 

you want to RENAME it), always ensure you move ALL 3 FILES . (Advanced 

users can COPY or DELETE files by using th eir GS System Utilities Disk ). 
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3.0 FILE FOLDERS 

Notes •n• Files simulates a real home or office environment by allowing you 

to place FILE FOLDERS in the Drawers of your Cabinet. You can have as 

many of these FOLDERS as disk space will allow. This depends on various 

factors , but you could have as many as a few hundred, up to several thousand 

FOLDERS within a Cabinet. 

OPEN THE BOTTOM DRAWER and we'll learn how to create a NEW 

FOLDER. Go down to the bottom left corner of the screen and DOUBLE-

CLICK on the Stationery ICON (which is pronounced "eye-kon" and means 

"a little graphic symbol "): 

I Stationery I 
The Stationery Window 

The Stationery ICON will open up into a new window which is called the 

"Stationery" window : 

QQ 
Letter Size 

3H5 

Legal Size 

~ 
~ 
Empty Folder 

Wide Paper 

This window can be thought of as a "STOCK SUPPLY SHELF " as it 

contains all of your "blank paper" and empty manila FOLDERS . 
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Moving the Stationery Window 
At this time, let's learn some things about the Stationery window. It can be 

moved about the screen by positioning the pointer in the top black part of the 

window, clicking and holding down the mouse button . 

D Stationery 

Then, while moving the mouse, a "ghost" rectangle will likewise move on the 

screen . This activity is known as DRAGGING the window. The window will be 

moved to the position of the "ghost" rectangle upon releasing the mouse button. 

Should you not like the window's position you can always move it again. The 

most common reason for wanting to move the Stationery window is so that you 

can work with its contents while also working at the same time with other items on 

the screen (such as FOLDERS or Documents) . 

When this window contains many DOCUMENTS you will be allowed to 

SCROLL the window (as explained later) in order to access them. 

Closing the Stationery Window 
The window can be closed away by clicking in its CLOSE BOX (also known 

as the "go-away" button): 

~ Stationery 

Creating a New Folder 
A NEW FOLDER is always created using the "Empty Folder" from the 

Stationery window. After bringing up the window, position the pointer on the 

"Empty Folder" icon and then DOUBLE-CLICK the mouse button: 

~lllllllll~:[illl~~::::::::::~I 
Empty Folder 
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The Folder Summary 
The "Empty Folder" icon will open up into a new window called the "Folder 

Summary ": 

D . . . . ·- Empty Folder . · ·· , . 

. Name 
: I 

Company 

Address 

City 

Phone 1 

Misc. 1 

State I Zip Code 

Phone 2 

Misc . 2 

Misc. 31 Misc. 4 Labels: I Letters : 

Comments: 

The FOLDER SUMMARY can be thought of as a piece of paper "stapled" to 

the inside cover of a FOLDER that summarizes its contents. 

Folder Fields 
The little rectangular "boxes" on the left half of the window are called 

FOLDER FIELDS . In these FIELDS you can enter a person's name and 

address, as well as other pertinent information about him or her. 

On the right half of the FOLDER will eventually be a LIST of the Documents 

that are inside this FOl:.DER. The Documents will be displayed in order of their 

creation dates, that is, the time they became filed into the FOLDER. The list 

will then serve as a type of running LOG, thus the term "Folder Summary". 
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How to Enter Data 
You will notice a blinking cursor in the "Name" FIELD . This represents the 

"point of insertion" and indicates the position of where the next character will 

appear as you type. Begin typing in your name and you will notice how this cursor 

advances to the right: 

I Name 
Adams, Johnl 

If you make a typing mistake, you can use the BACKSPACE key to delete 

characters to the left of the cursor (and the cursor will likewise move backwards). 

Changing Fields 
When you are done typing in your name, you can move over to another 

FIELD by pressing the TAB key (or by using the ARROW keys) . Press ing 

RETURN will advance the cursor down to the next row of FIELDS (but not 

across a row) and SHIFT-TAB (holding down the SHIFT key while pressing 

TAB) will advance the cursor back to the previous FIELD. 

Editing a Field 
Another way to change FIELDS is to place the POINTER in the desired 

FIELD (just below the TITLE of the "box"), and then click the mouse. A blinking 

cursor will appear in that FIELD and you may then begin typing as usual. 

Fine Editing 
You can also position the pointer BETWEEN characters and click the mouse 

in order to insert the cursor for further, refined Editing. Below you see an 

example of handling a misspelled name. We will insert the cursor between the "J" 

and "h", and then type in an "o" to correctly spell the name "John" : 

I 
Name 
Adams,J~="~~~~~~~~~~ 
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Saving the New Folder 
When all of the pertinent data has been entered into the FIELDS (you may 

leave any of them completely blank if you wish}, you can then Save thi s 

FOLDER into the Drawer by selecting "Save Folder" from the File menu: 

NHW C!~tlin<d 
D!H~n Cnt1in<~ t 
Close Cabinet 
Saue Folder c s 

Note that you can also press OPEN-APPLE S (simultaneously} instead of 

pulling down the File menu. Upon doing so, a NEW FOLDER will be created 

and filed in the Drawer AUTOM ATICALLY (which we shall prove very shortly). 

A WATCH may appear informing you of the fact that Notes •n• Files is 

currently BUSY creating your NEW FOLDER in your Cabinet: 

e 
Closing the Folder Summary 

You can put away the Folder Summary window by clicking in its CLOSE 

BOX: 

~l::IWE@i 
I Name lloate 

If you have already Saved the FOLDER, the Summary window will then 

disappear from the screen. However, if you type something and click the window 

away BEFORE you Save the FOLDER, you will receive the following prompt: 

Soue changes before closing? 

[( Yes )] 

No Cancel 
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Clicking on the "Yes" button (or pressing RETURN) will Save the FOLDER 

.fill.Q put the Summary window away. Clicking "No" will Close the Summary 

window without creating the FOLDER. Clicking "Cancel" will return you back to 

the Summary FIELDS for further editing. 

Note that you can always perform the "trick" of bringing up a new FOLDER. 

typing in some data and then clicking the Close Box in order to get the above 

prompt, thereby allowing you to Save the FOLDER and. Close the window all in 

one step! 

Adding a Folder to the Drawer 
When you Save your NEW FOLDER, and Close the Summary window, 

you will notice that, indeed, your FOLDER has been added to the Drawer! (Note: 

You may want to move or close the Stationery window for a better view): 

The RULE is that a NEW FOLDER is always added and filed into the 

CURRENTLY OPENED DRAWER upon Saving. However, if NO DRAWER 

IS OPEN at the time then the FOLDER will be filed in the TOP DRAWER. 

(Note that when a FOLDER is Saved, it may also be filed within the other 2 

INDEXES, as explained much later). 
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3.1 Data Entry 

IMPORT ANT NOTE: Before you begin adding all of your Folders to the 

Drawers you should read the following information ao.ct you might want to wait 

until you study and fully understand the INDEXES, as explained in CHAPTER 

6, page 65. Furthermore, there are 2 FIELDS reserved for writing back "flags " 

and any data you enter into them may be possibly over-written during the 

printing process, as explained in CHAPTER 7, 85. 

Quantity of Folders 
As we mentioned, you can create as many Folders as a disk will hold. The 

actual disk space used is calculated strictly by the AMOUNT OF DATA you 

type into the FOLDER FIELDS . If you enter just names and addresses, then 

you could easily get 2,000 Folders into one Cabinet on a single 800k floppy disk, 

or many thousands of Folders on a hard disk. 

Abbreviations 
It is not well known exactly how to enter RECORDS . There are specific rules 

that should be followed. These rules can be found in PHONE BOOKS, or ZIP 

CODE BOOKS and from other such references. 

To economize on disk space used, knowing how to ABBREVIATE data 

becomes vitally important. For example, suppose you have 1,000 folders and 

that each person's address contains the word "STREET". This word is 6 

characters long and with 1,000 folders this adds up to 6,000 total characters , 

quite alot of valuable disk space! Using abbreviations, as suggested in the 

references given above, the word "STREET" can be written as "ST". By knocking 

off 4 characters, you would save 4,000 total characters! 

Also, by reducing the amount of PERIODS used within a record, vital disk 

space can be reserved for many more FOLDERS, not to mention new 

CABINETS. 
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Some example ABBREVIATIONS are given below : 

WORD 
APARTMENT 
AVENUE 
BOULEVARD 
BUILDING 
COMPANY 
EAST 
FLOOR 
INCORPORATED 
MAIL STOP 
NORTH 
NORTHEAST 
PARKWAY 
PLACE 
PLAZA 
POST OFFICE BOX 
RURAL ROUTE 
SOUTH 
SOUTHWEST 
STREET 
SUITE NUMBER 10 
WEST 

ABBREVIATION 
APT 
AVE 
BLVD 
BLDG 
co 
E 
FLR or FL 
INC 
MS 
N 
NE 
PKWY 
PL 
PLZ 
POB or BOX 
RR 
s 
SW 
ST 
#10 
w 

You must NEVER abbreviate something if you aren't exactly sure how to do it 

because if you are sending a fetter to somebody, and the postman can't tell what 

you mean, your letter may not arrive at the correct address! 

Abbreviations are quite acceptable, but above all be CONSISTENT. For 

example, should you enter "STREET", then on another Folder put "STR" and 

the others "ST', then when you search for Folders, or print conditionally, some 

Folders will NOT be found and therefore will be skipped. 

Mailing Labels & Form Letters 

Another consideration to bear in mind is how the data will appear when 

printing Mailing Labels or Form Letters. The data from any of your Folder Fields 

can be EXTRACTED and printed on Labels or inserted into Form Letters . 
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Now, consider the fact that if you were to enter the "Company Name" as 

"Acme Parts Supply House of the South , Incorporated ", then you can be 

assured that this STRING will run off a Label during printing, and will perhaps 

even "spi ll over" to the next Label (if you are using more than one Label across) . 

You would be much better off using "Acme Parts, Inc". Unless that company 

really cares about it, by all means SHORTEN the name as much as possible. 

Needless to say, you are at your own risk should you "go overboard" and enter 

the name as "Acm. Prts" or "APSHOTS, Inc". 

The LENGTH OF DATA entered into your Folder Fields is therefore 

important not only because of the disk space factor, but for the APPEARANCE 

of the data during printing. With all of this in mind , decide on some sort of 

STANDARD for entering your data. This wi ll not only give you professio nal 

looking Documents, but the "turn over" to another DATA ENTRY TYPIST will 

go smoothly. 

Miscellaneous Fields 
The final point to make concerns the FIELDS that play a vital role in using 

Notes •n• Files to its full est. These are the "Misc." FIELDS located at the 

bottom of the Summary window. These FIELDS can hold vario us KEY 

CODES which can later be used for special searches and conditional 9rinting. 

You could, for example, enter NUMERICAL VALUES that represent certain 

things just to you. You could let a "1" represent a "preferred customer" and in the 

future you can tell Notes •n• Files to find ALL Folders containing a "1" in that 

particular FIELD, and then print a letter to iJ.!fil these people. Get the idea? 

You can become quite creative with these spec ial CODES , and we shall 

learn some more "tricks" about them later on, but for now we want you to at least 

begin considering this before you dive in and type 1,000 names. Having to go 

back and change the data in each and every Folder would be quite a nightmare! 
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3.2 Filing Folders 

Creating Multiple Folders 
You don't have to put away the Folder Summary window and then re-open 

the "Empty Folder" to create another new Folder. Instead, when you are ready 

to Save the Folder, you simply select "Save & New" from the File menu: 

Netv Cntline t 
01H~n Cnt1inc~ t 
Close Cabinet 

Note that you can type OPEN-APPLE N instead of pulling down the File 

menu. The new Folder will be Saved fillQ added to the Drawer, as usual, but this 

time the Folder Summary window will clear all its FIELDS allowing you to 

type in fresh data for another new Folder. 

Thus, to create 1 OO's of Folders in a single session you keep entering names 

and selecting "Save & New". When done with the final Folder, you can Close 

the window and you will find that all the Folders have been added to the Drawer. 

The Filing RULE 
The RULE to remember is that when you create a Folder it is always filed in 

the opened Drawer IN ALPHABETICAL ORDER. The Folders will thereafter 

be displayed according to the data entered in their "Name" FIELDS . For 

example, if you type the name "John Adams", then this Folder will be found in 

the Drawer under "J" for "John". Should you enter it as "Adams, John", the.n the 

Folder will appear in the front of the Drawer along with the other "A's". Note that 

if the "Name" starts with a SPACE (the first character of the "computer 

alphabet"), then the Folder will always be filed as the very first one in the Drawer. 
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Also, keep in mind that NUMBERS always come Q.filQN LETTERS and any 

Folders using NUMBERS instead of names will be filed in the Drawer QfilQN the 

"A's". ASTERISKS come before both letters and numbers and can be used to 

file a Folder "up front" in the Drawer, such as calling a Folder ... Things to Do". 

Last Name, First Name 
The reason for entering a name using Last Name, First Name is so that it 

can be conveniently filed in the Drawer .ao..ct. easily located in the future. 

"Adams" would be easier to find than if you had to search through all of the 

"Johns"! Also, keep in mind that when you print a Mailing Label or a Form Letter, 

Notes •n• Files will REVERSE the Last Name and First Name , if you wish, 

so that "Adams, John" will be printed as "John Adams". 

Using SUBJECTS 
You may want to dedicate your Folders just for SUBJECTS . In this case you 

can type the SUBJECT title into the "Name" FIELD rather than a person's 

name. The Folder will then be filed alphabetica lly in the Drawer, in the usual 

manner, according to the first letters of that SUBJECT . Below is an example ~ 

"Poetry" Cabinet: ~ 

By using SUBJECTS, you can gather together various notes and memos for 

that particular subject, and file them into their proper Folders. This allows you to 

organize, for example, your personal areas such as bills, plans, schedules and 

other such matters not directly related to a "person" type folder. 
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3.3 Using Folders 

Getting a Folder 
Open the bottom Drawer , place the pointer on the name "Adams, John", and 

DOUBLE-CLICK the mouse button. The Folder will "fly" out of the Drawer and 

appear on the desktop (screen): 

' Q . Rdams, John 

- empty -

Folder Summary 

Notice how the original Folder "card" in the drawer remains HIGHLIGHTED 

as long as the Folder is out of the Drawer, thus serving as a MARKER. Notes 

•n• Files won't ever let you "lose" a Folder like you can in your real office! 

Moving a Folder About 
A Folder can be conveniently moved around the desktop . Place the pointer 

on the Folder's top black part and while holding down the mouse button, DRAG 

the Folder to a new location . The Folder will be repositioned on the screen at the 

current location of the "ghost" rectangle upon releasing the mouse button. 

D Rdams, John 

- empty -

Folder Summary 
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Opening Up a Folder 
When you take a Folder out from the Drawer and put it on the desktop, you 

can then open it up by DOUBLE-CLICKING on its left half, as shown below. 

(Note that you can also OPEN a Folder directly from the Drawer by holding down 

the SHIFT key while DOUBLE-CLICKING its "card"). 

D Rdams, John 

ii . 
. . 
. 
. 

Folder Summary 

- empty -

The FOLDER SUMMARY will then appear on the screen and you may edit 

the data in any of the FIELDS as desired. If you do make a change to a FIELD, 

such as updating an 'address or adding a "code", etc., you will then need to select 

"Save Folder" from the File menu. This will Save the Folder back in the same 

Drawer by REPLACING the original contents with the new data. NOTE: If you 

make a change to the "Name" FIELD, the FOLDER will then be filed in the 

Drawer according to the NEW NAME! 

If you also hold down the SHIFT key when you Close the Summary 

window the Folder will not only "close up", but return back into its Drawer! 

Moving a Folder to Another Drawer 
Since a Folder is always Saved to the CURRENTLY OPEN DRAWER, 

you can TRANSFER A FOLDER by opening the other DRAWER and Saving 

the open SUMMARY. The Folder will thereafter be found in the new DRAWER. 

Putting a Folder Away 
A FOLDER can be returned to its Drawer by clicking in its CLOSE BOX: 
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3.4 Renaming Folder Fields 

The FOLDER SUMMARY FIELDS can be renamed as desired. When you 

bring up the Summary window AND haven't typed anything yet, you can then 

select "Rename Folder Fields" from the Edit menu : 

The FOLDER FIELD TITLES will drop down into their "boxes" allowing you 

to edit them: 
Name 
Clients! 
Company 
Compan1t 
Address 
Address 

You can TAB through the FIELDS or click into place the blinking cursor , 

backspace out the characters and type in the new FOLDER FIELD TITLES of 

your choice. 

When satisfied, you then select "Save Folder " from the File menu . (Note 

that this will merely Save the TITLES and D..Q1 make a new Folder). Notes •n• 

Files will then Save these FOLDER FIELD TITLES by modifying the "Emp ty 

Folder" on the Statione ry window. This also automatically cha nges EVERY 

FOLDER SUMMARY within the entire Cabinet. 

The FOLDER FIELD TITLES can be changed and saved UNIQUEL V for 

each of your Cabinets. 
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3.5 Importing Other Data Bases 

NOTE: If you do .D.Q1 have a data base that already exists in another program 

then this next section will not apply to you. 

Setting Up Your Text File 

You can move the existing data from another data base program directly into 

Notes •n• Files . However, in order to do this you first have to have a TEXT 

FILE already SET-UP to be transferred. There are certain conditions that~ 

be met in order for Notes •n• Files to accept your data base. The FIELDS of 

the data base to be Imported ffil.!..fil be arranged in the SAME EXACT ORDER 

as the FOLDER SUMMARY (as if you TABBED through the Summary 

window and entered the data by hand). Your data base program must then be 

able to Save the data as a TEXT FILE with fillQ.b_ FIELD separated by a 

CARRIAGE RETURN. If your program cannot re-arrange FIELDS or Save 

the data as "RETURN delimited text files", then you will have to call DataPak's 

Technical Support Division for further instructions. 

An example using AppleWorks ™ is given below: 

1) Draw the FOLDER SUMMARY FIELDS on a piece of paper so you can 

know exactly how to modify your data base records. 
2) Go into AppleWorks ™ and load in your data base file in the usual way. 

3) Decide which FIELDS you want to use (up to a maximum of 15). 

Re-arrange the order of these fields so that they exactly match the Notes 

•n• Files Summary layout. (NOTE: If your records are formed with the 

first & last names being 2 separate fields, then you will need to call 

DataPak's Tech Support Division for special help). 
4) You will be limited to 40 characters per FIELD (excess will be ignored). 

5) Don't forget to allow for the 2 "FLAG" FIELDS (explained in CHAPTER 

7, page 85). 
6) Keep a note as to how many FIELDS a record has. 

7) You can then proceed to "print" the data base to a TEXT FILE . This file 

will be the one Notes •n• Files will eventually accept. 
8) Load in another data base file and continue this process until you've saved 

all the ones you want to convert. (You may have to "Remove" a file from 

memory in order to load another). . 

9) When finished, Quit AppleWorks ™ and run Notes •n• Flies . 
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Converting the Text File 
Bring up your Cabinet, open the Drawer you want your NEW FOLDERS to 

be created in and then select "Import Text File 11 from the File menu. You will 

then be given a list of your available TEXT FILES. (You may need to use the 

"Disk" button to access other disks). Select the FILE you wish to IMPORT by 

clicking on its NAME and clicking on the 110pen 11 button. After this a new window 

will appear asking you HOW MANY FIELDS A RECORD HAS. Enter the 

amount and click "OK" or press RETURN. A WATCH will appear informing you of 

the fact that Notes •n• Files is currently BUSY reading and processing the 

data from your FILE and creating NEW FOLDERS in your Cabinet: 

~ 

When the ARROW pointer returns you will then discover that all of your NEW 

FOLDERS have been added to the Drawer and will appear in alphabetical order 

by NAME, that is, according to the very first FIELD of EACH IMPORTED 

RECORD. The 2 INDEXES (see CHAPTER 6) will also be created. You can 

set these up miQr to IMPORTING, or you can set them afterwards. 

Warning About Importing 
As previously mentioned, your TEXT FILE must be properly formatted. If 

you attempt to IMPORT an incorrectly formed data base, then the NEW 

FOLDERS created in your Cabinet will contain data in the wrong FIELDS. Also, 

if there is not enough disk space left in which to create a NEW FOLDER then 

the conversion process will abort and skip the remaining records not yet read. 

For these reasons you should n.Q1 use a Cabinet already containing Folders, but 

instead create a 11test" CABINET and IMPORT "the data into it. If anything "goes 

wrong" you can always create another Cabinet again and start over. For a 

Cabinet that already has some Folders, you could first make a copy of this 

Cabinet (using your System Utilities Disk) and then IMPORT into the copy. If 

successful you would then delete the original Cabinet and make your newly 

IMPORTED Cabinet the 11master" Cabinet. 
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4.0 DOCUMENTS 

NOTE: Before beginning this next section, get a Folder from the Drawer (or 
make a new one) and bring it out onto the desktop (as shown back on page 29). 

Creating a DOCUMENT is just as easy as creating a new Folder for it is done 

almost exactly the same way. Position the pointer on the Stationery ICON at 

the bottom left corner of the screen, and then DOUBLE-CLICK the mouse 

button. Upon doing so, the ICON will open up to the familiar Stationery window. 

You then select which size paper you wish to use by DOUBLE-CLICKING on 

that ICON, such as the 3 X 5 size shown below being chosen. (If you want, you 

may always drag an ICON off the window and onto the desktop for 

convenience). 

3 H 5 

This will bring up a new, "Untitled" DOCUMENT window: 

As usual, you can DRAG this window about the screen for convenience. 

Try typing a few words on this DOCUMENT window. (We wil l be learning all 

about the Editor in the next chapter). 
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Saving Your Document 
When you have finished typing something, select "Save Document" from 

the File menu. Note that because you are working on a DOCUMENT (and not a 

Folder) this menu item will change to say "Save Document" (but you may still 

use OPEN-APPLES): 

Upon doing so a new little window will appear: 

Saue Document Named: 

lllhifiirli\j 

[~] [ Cancel ] 

Naming Your Document 
The default name "Untitled" appears in the edit "box". Type in a new name for 

your DOCUMENT, such as "My Document": 

I My Document! 

When ready, click the "OK" button, or press RETURN. Clicking the "Cancel" 

button will return you back to your DOCUMENT without Saving it. 

A DOCUMENT NAME is limited to a maximum of 19 characters. (Note 

that you ~ use spaces within a TITLE). You might want to name your 

DOCUMENT something you can easily remember in the future so that you can 

always find it again when needed. 

For example, you could include a person's name like "Note to Joe" or use 

today's DATE as part of the title such as "May 12th Letter", and so forth. 
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Save Document As ... 
Selecting "Save Document As ... " from the File menu works the same way 

as "Save Document" except this time you will be creating a brand NEW 

DOCUMENT and you will be asked to give it a NAME. The DOCUMENT will 

be Saved newly, keeping the ORIGINAL INTACT . This is how you could 

create a COPY of a DOCUMENT. 

You can also bring up a previously created DOCUMENT, make some 

changes to it and then Save it As a new, yet different DOCUMENT, and 

without altering the older, original DOCUMENT . 

Closing the Document 
You can put the DOCUMENT window away by clicking in its CLOSE BOX: 

If you have typed someth ing, but haven't yet Saved the DOCUMENT, you 

will be prompted: 

Saue changes before closing? 

[( Yes J] 

No Cancel 

Clicking "Yes", or pressing RETURN, will Save the DOCUMENT, but since it 

is "Untitled", you will be asked to give it a name (as described above). Clicking 

"No" will Close the window without Saving the DOCUMENT and clicking 

"Cancel" will take you back to your DOCUMENT for further editing. 
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4.1 Filing Documents 

When you Save your new DOCUMENT , Notes •n• Files files it for you 

AUTOMATICALLY . As you can see, a little DOCUMENT ICON will appear on 

the Folder representing the fact that there is a DOCUMENT inside: 

D . · Adams, John 

Folder Summary 
My Document 

Notice the markings on the DOCUMENT ICON . This lets you know that it is 

a TYPED DOCUM ENT, versus a "blank" piece of Stationery paper. 

Saving Rules 
The RULE to remember is that when you Save a DOCUMENT it will always 

be filed into the CURRENTLY ACTIVE FOLDER, the one that is "OUT OF 

THE DRAWER AND ON THE DESKTOP". However , if there is ID..QLe. than one 

Folder on the desktop at the time, then the DOCUMENT wil l end-up in the 

FRONTMOST FOLDER : 

Of course, when a DOCUMENT window is in FRONT of the Folder s then 

the destination will be the very first Folder BEHIND the DOCUMENT window. 

This destination Folder will also have been the LAST USED FOLDER (usually 

because it had just been brought out of the Drawer). 
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Saving to the Stationery Window 
If there is NO FOLDER upon the desktop at the time, the DOCUMENT, 

:1aving nowhere else to go, wil l be Saved upon the Stationery window (since 

this window works like a "STOCK SHELF"). 

Thereafter, if you want to, you can move the DOCUMENT from the 

Stationery window and put it iD.1Q a Folder. 

Moving Documents 
A DOCUMENT can be DRAGGED about the desktop for convenience or 

moved from one Folder to another, or as previously mentioned , it can be 

transferred from the Stationery window and put inside a Folder. 

Below is an example of transferring a DOCUMENT from one Folder to 

another. All you do is DRAG the DOCUMENT from the first Folder over to the 

second Folder and "drop" it in: 

0 Adams, John 

Ii ~~~l~,111 Smith, Joe 

L. ..... ~.l 
Folder Summary 

II Folder Summary 

When you release the mouse button, the "ghost" Document will "fall" into the 

destination Folder. The original DOCUMENT will then be moved over and filed 

into the new Folder and will no longer exist in the source Folder. You may 

likewise bring out a Folder from the other Drawer and move DOCUMENTS 

over to it, thereby transferring DOCUMENTS from Drawer to Drawer. 

(NOTE: If you move a DOCUMENT from a Folder and put it on the 

Stationery window, it will be re-filed into its Folder when you Quit the program). 
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4.2 Opening Documents 

You can RE-OPEN a DOCUMENT by positioning the pointer on its icon 

and DOUBLE-CLICKING the mouse button : 

My Document 

The DOCUMENT will open up into the original window you typed on. You 

may then either review its contents, edit the text or just close the window away. If 

you make any changes, of course, you will want to Save them by using "Save 

Document" from the File menu, or close the window and be prompted. 

Thumbing for Documents 
The little "dog ears" on a Folder are for THUMBING through the 

DOCUMENTS that are in the Folder. Clicking the "triangle" on the right will 

display the next DOCUMENT ICON, if any, and the left one will "flip" back to the 

previous ICON. 
D Adams , John 

Folder Summary 
My Notes 

Note that as you click forwards through the ICONS, and you reach the last 

DOCUMENT in that Folder, the next ICON displayed will be the very first one 

agai n. However, you aren't allowed to "thumb" backwards start ing from the first 

DOCUMENT trying to go straight to the last (bottom) ICON . 

By "thumbing" through a Folder this way you can "spot" the desir ed 

DOCUMENT and OPEN it up right then by DOUBLE-CLICKING on its ICON. 
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The Folder Summary Log 

DOCUMENTS are always filed within a Folder according to their actual 

creation DATES . The VERY LAST DOCUMENT CREATED will be "on top of 

the pile" inside the Folder, just like a real office. This is also the exact same order 

in which you see the ICONS while "thumbing". 

As you may recall, when you re-open a Folder, the right half of the FOLDER 

SUMMARY will display a list of the DOCUMENTS that exist inside the Folder. 

This area is known as the FOLDER SUMMARY LOG: 

The LOG will show you the DOCUMENT'S CREATION DATE in one 

column and its TITLE in the other. 

You can RE-OPEN a DOCUMENT directly from this Summary window by 

simply DOUBLE-CLICKING upon its NAME (as shown above with "Letter to 

Joe" about to be chosen). 

When the LOG contains numero us DOCUMENTS, too many to be 

displayed on the Summary window, you can "scan" through the remainder of 

the LIST OF DOCUMENTS by using the SCROLL BAR (UP or DOWN 

ARROWS along the right side of the window) in order to locate the ones you 

want to use. 

We shall learn all about the SCROLL BAR in the next chapter. 
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4.3 Importing & Exporting Text 

A TEXT FILE is a file that you can create on your disk containing just letters, 

numbers and puncutation 111arks you typed on your DOCUMENT and it will not 

have any FONTS or STYLES (these features will be "stripped out") . By using 

TEXT FILES, different programs on your GS can "share" the data. An example 

using AppleWorks ™ is given below: 

1) Go into AppleWor ks™ and load in your word processing files in the usual 
manner. 

2) Immediately "print" it to a TEXT FILE. 
3) You may continue this process with your other word processing files (you 

may have to "Remove" them from memory when done in order to load 
another). 

4) When all files have been Saved as TEXT FILES , you may then go into 
Notes •n• Files and IMPORT them as explained below: 

Importing a Text File 
Bring up a new DOCUMENT window (or open;ng an existing one) and 

select "Import Text File" from the File menu. You can then choose from the 

LIST of TEXT FILES the one you wish to IMPORT. The TEXT FILE will be 

read from the disk and inserted into your DOCUMENT at the CURRENT 

POSITION of the cursor . You can edit the data as needed and then Save the 

DOCUMENT into a Folder as usual. Note that the IMPORTED TEXT is .QD1y a 

"copy in memory" (until you Save it) , and if you Close the DOCUMENT 

without Saving it, you will have effectively cancelled the IMPORT activit y! 

Exporting a Text File 
To create a TEXT FILE from your DOCUMENT you first open it up on the 

screen (or bring up and type a new one) and then select "Save As Text" from 

the File menu . You will be asked to give the TEXT FILE a name . Click the 

"Save" button to begin the process. A new FILE will be created on your 

destination disk that can later be read and used by your other GS programs. 
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5.0 THE EDITOR 

Notes •n• Files has a built-in Editor that is as easy to use as a typewriter. 

Unlike an ordinary typewriter, the Editor allows you to type words in various 

shapes and sizes right on your GS screen, and by using the mouse you can 

quickly and easily change the appearance of these words or move them around 

to different places within your document at will. You can also correct any typing 

mistakes you might make (and without having to use "white-out"!). 

Bring up a new, 3 x 5 Document from the Stationery window and begin 

typing "This is a test of editor ." (leaving out the word "the" before "editor") : 

This is a test of editor.I 

The I-Beam Pointer 
The blinking cursor advances to the right indicating the eventual position of 

the next typed character. Note that the POINTER has changed from an 

ARROW to what we call an "I-Beam": 

I 
You can change the position of the cursor by 1} maneuvering the I-Beam 

between characters, clicking the mouse to insert the cursor at this new position 

and 2) resume typing. For example, to add the word "the" you insert the cursor 

to the left of the "e" in "editor" and type in the word (adding a space character at 

the end): 

1) This is a test ofleditor. 
2) This is a test of the ~ditor . 
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Highlighting Text 
The way you tell Notes •n• Files which words or characters you want to 

change is by HIGHLIGHTING them. Position the I-Beam again just to the left 

of the letter "e" in "editor": 

This is a test of the editor. 

Click and hold down the mouse button and DRAG the I-Beam to the right 

across "editor" so that this word becomes HIGHLIGHTED (selected): 

This is a test of the m!lll!D 
--+ 

(You could have started to the right of "editor" and dragged to the left). 

The Font Menu 
When some text has been SELECTED, you can then perform various 

operations upon it. For example, let's change its shape and size by 1) selecting 

Helvetica from the Font menu and then 2) 18 Point size from the Style 

menu: 

__J ~ 
1) EJE±±i@ 

- ~ 
2) 9 Point 

J 
01 
02 

Both times you will see the word "editor" change on the screen. As the _word 

remains HIGHLIGHTED you can try out the different FONTS and SIZES. 

This is o test of the mum. 
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A FONT can be thought of as a unique alphabet set that is comprised of 

characters with the same shape and size. (You might even want to type the 

alphabet on a Document and print this set for future reference). The most 

common way to use a FONT is to first select one and then begin typing. Note 

that the currently selected FONT will always be --/check-marked on the menu. 

The Style Menu 
You can also change the Style of a particular FONT. Let's select 

"Underline" from the Style menu: 

You can also use OPEN-APPLE U instead of pulling down the Style menu. 

The HIGHLIGHTED word "editor" will then be shown in Underline: 

This is e test of the r:tiR(il'j. 
You can also choose any of the other Styles or use them in combination . 

The currently selected ones will always be --/check-marked on the menu. To 

cancel fill Styles you would select "Plain Text" . To have a better view of the 

above example, click once anywhere on the Document window. Note that any 

HIGHLIGHTING will always be eliminated upon performing a single-click. 

Other Ways to Highlight Text 
DOUBLE-CLICKING ON A WORD (2 quick presses of the mouse button) 

will HIGHLIGHT that particular word. SHIFT-CLICK (holding down the SHIFT 

key while clicking) will HIGHLIGHT ALL OF THE TEXT BETWEEN THE 

CURRENT LOCATION OF THE CURSOR AND THE POSITION OF 

THE CLICK. In this way, entire sentences or even multiple paragraphs can be 

selected and operated upon. 
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5.1 Cut/Copy/Paste 

The Edit Menu 
The Edit menu offers some "tools" that you can use while working with a 

Document. It will allow you to Cut words or characters out of your Document, or 

Copy them and Paste them back into your Document at another location. 

These are used so often that they have keystroke equivalents for them: OPEN 

APPLE-X to Cut, OPEN APPLE-C to Copy and OPEN APPLE-V to Paste . Notice 

how these 3 keys are conveniently altogether at the left side of the keyboard. 

Removing Text 
It is very easy to REMOVE text from a Document. The easiest way, of 

course, is to use the BACKSPACE key. Another way is to highlight the desired 

text and then press BACKSPACE or just start typing . The first keystroke will 

eliminate the highlighted text before inserting the newly typed characters. The 

text will be removed permanently. (However , if "Undo" is active on the Edit 

menu, you may select it to cancel the last activity). 

Cutting Text 
A more sophisticated way to remove the text is to highlight the desired section 

and then Cut it from the Document by selecting "Cut" from the Edit menu, or 

press OPEN APPLE-X: 

Copy o C 
Paste o U 

When you Cut out some text, it isn't gone forever. It goes into what we call the 

Clipboard which "stores" the text in memory for future use (replacing whatever 

text was there before it). 
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The Clipboard 
You can always review the contents of the Clipboard by selecting "Show 

Clipboard" from the Edit menu. The Clipboard window will then appear at the 

bottom of the screen and can be dragged upwards for a better view. It can put 

away by clicking in its CLOSE BOX or by selecting "Hide Clipboard" from the 

Edit menu. 

Copying Text 
Another function you can employ while text is highlighted is to make a Copy 

of it. By selecting "Copy" from the Edit menu, the highlighted text will also be 

moved into the Clipboard, that is, a Copy is saved away in memory, but this 

time the highlighted text will NOT be taken away from the Document. Therefore, 

the ~ difference between Cut and Copy is that Cut always REMOVES the , 
text from the body of the document. They both will "save" the text onto the 

Clipboard. 

Pasting Text 
When the Clipboard has some text in it, either by Cut or Copy , you can then 

take its CONTENTS, and Paste it anywhere back INTO your document. To do 

this, position the I-Beam pointer and click the mouse button to insert the cursor 

at the desired STARTING location. Upon selecting "Paste" from the Edit menu 

the text will be INSERTED into the Document beginning at this point. The 

Pasted text will appear while retaining its original FONT and STYLE. However, 

if any text is HIGHLIGHTED at the time of selecting "Paste", then this text will 

first be eliminated (without being Copied) before the new text is inserted. 

Copy & Paste Between Documents 
The contents of the Clipboard can also be inserted into other Documents . 

Copy some text, Close the Document, Open a different one and Paste the 

text (at the location specified by the cursor), and then Save the changes. 
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5.2 Formatting a Document 

The actual formation of text within the body of a Document is called 

"FORMATTING". The sentences and paragraphs of your Document can be 

arranged on the screen using one of four possible ALIGNMENTS: Left ; Right; 

Centered or Fully Justified . You can select the type of justification from the 

Format menu and begin typing, or for previously typed text, you can highlight 

multiple paragraphs and then select the justification to change them all at once. 

Left Justify positions each given line of a paragraph at the LEFT SIDE of 

the Document. This is the DEFAULT setting for when you first bring up a new 

Document window. 

Right Justify forces each line to end exactly on the RIGHT SIDE of the 

Document. In the example below, we have typed a few sentences and 

highlighted all of them. Then. when we selected "Right Justify" from the 

Format menu, all of the text moved over to the RIGHT MARGIN: 

Center Justify places the text at an EQUAL distance between the LEFT 

and RIGHT MARGINS: 

Ju stif y test 
Justify test 
Justify te stl 

47 



Full Justify is a type of alignment where the text is both LEFT AND RIGHT 

JUSTIFIED at the same time. If the words of the sentence do not add up to a full 

line across the page, then Notes •n• Files cleverly adds spaces between the 

words until they all "fit" evenly on that same line. 

Single & Double Line Spacing 

A Document can also be typed using SINGLE or DOUBLE SPACING . 

Selecting "Single Spacing" from the Format menu will insert a BLANK LINE 

between every line. Re-selecting "Single Spacing" will remove the added lines 

(as shown right here on this line). The SPACING always affects every line within 

a given paragraph, but you~ use different SPACINGS for each paragraph. 

Pages 
A Document is actually comprised of individual PAGES. A line will be 

displayed across the screen (which is known as a PAGE BREAK) representing 

the END of a PAGE in your Document. Each PAGE therefore represents ONE 

PIECE OF PAPER , the sheet that will be used during PRINTING. Note that a 

PAGE BREAK depends entirely upon which SIZE PAPER you are using. 

The Page Number that you are currently typing in will always be shown at 

the lower left corner of the window: 

!Page: 1 

Page Limitations 
Notes •n• Files LIMITS the amount of pages you can type for each 

Document to 1 O pages which is well above the size needed for a common 

memo, note or business letter. However, this may fall short if you want to type· 

longer Documents . One remedy is to create another new Document as a 

continuation of the first, perhaps naming it" My Report Paye 2", etc. 

NOTE : Always Save a Document from time to time when typing a lengthy 

Document for "insurance" against the computer shutting down unexpectedly! 
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Scroll Bars 
By clicking on the ARROWS of the SCROLL BARS you can move the 

contents of the Document up or down, left or right: 

in the morning 
in the morning 

l autumn leaues 

Holding down the mouse button on an ARROW will act like "consecutive 

clicks" and continue moving the contents. 

Clicking on the actual gray part of the SCROLL BAR will advance the 

contents many lines at a time (the direction depending upon which side of the 

THUMB you click on). 

The Thumb 
You can "jump" over PAGES by dragging the white rectangle called the 

"THUMB": 

The THUMB is positioned along the SCROLL BAR in the exact 

PROPORTION of the contents you currently see with respect to the ENTIRE 

DOCUMENT. For example, if the THUMB is at the top of the SCROLL BAR, 

then you will always know you are at the very beginning of your Document. If you 

drag the THUMB to the middle of the SCROLL BAR, and release the mouse 

button, the Document will then be shown at its halfway point. Dragging it to the 

bottom takes you to the very end of your Document. 

Note that the Page Numbers will change (in the bottom ·left corner) as you 

scroll through your Document, thereby enabling you to locate a specific PAGE. 
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5.3 Ruler Settings 
I~ ; I I I I I 11' I I I I I I 12' I I I I I I 13' I I I I I I lq I I I I I I ~5 I I 

Th e RULER is used as a "measuring stick" . Althou gh it is displayed across 

the top of your Document, it is only IMAGINAR Y in that it will NOT appear when 

you print your final Document. It simply serves as a "guide" for FORMATTING 

your Documents. 

By selecting various SETTINGS for a RULER , the text can be "molded" or 

confined within certain boundaries dictated by left and right margins, or it can be 

forced into certain positions on a line by using what we call TAB MARKS. 

Rulers vs. Paragraphs 
A RULER is always related to a specific PARAGRAPH . There is only one 

RULER PER PARAGRAPH and EVERY PARAGRAPH will use a RULER. A 

PARAGRAPH can be simply defined as a body of wo rds or sentences that 

ENDS WITH A CARRIAGE RETURN . When you are typing, as soon as you 

press the RETURN key, the PARAGRAPH ends and a new one begins. A new 

RULER is automatically created for th is new PARAGRAPH and will be an exact 

"copy" of the RULER used in the PARAGRAPH just finished. 

A RULER is always set for each particular PARAGRAPH without affecting 

any other PARAGRAPHS in til e Document. The RULE to remember is: 

THE RULER YOU SEE ON THE SCREEN WILL ALWAYS PERTAIN 

TO THE PARAGRAPH THE CURSOR IS LOCATED IN AT THE TIME . 

Therefore, you will be able to have, if you wa nt, different settings for EACH 

PARAGRAPH in your Document. 
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Lef t and Righ t Margins 
The left and right sides of a document are called MARGINS . The RIGHT 

MARGIN can be set so that typing will never go past a specific point. In the next 

example, we place the pointer on the RIGHT MARGIN MARK : 

Then we drag this RIGHT MARGIN MARK towards the left to about the 2 

inch line. Upon releasing the mouse button , the text will CONFORM to the 

boundaries of our new settings: 

This is a test of ~ 
the editor. 

You will notice that the words "the editor. " moved down to the next line. This 

is because it would have extended PAST THE 2 INCH RIGHT MARGIN 

MARK. This is known as "WORD WRAP" for the text "wraps" around the 

MARGIN and appears on the next row. 

Paragraph Indentation 
The INDENTATION MARK , at the left side of the RULER, signifies where 

the FIRST WORD of a PARAGRAPH will begin. As you type, the sentence will 

"wrap" and the new line will resume at the LEFT MARGIN MARK : 

PARAGRAPH 
INDENTATION A paragraph begins at the "indentation" mark 
MARK and continues at the left margin mark . 
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The INDENTATION MARK can be moved by placing the pointer on it and 

dragging it to a new setting: 

h~paragraph begins at the "indentation" 
mark and continues at the left margin mark. 

You will see the text for that particular PARAGRAPH conform to the new 

setting. 

Left Tab 
A TAB MARK is used to designate where you want the cursor to go when 

you hit the TAB key. You may use up to 5 LEFT TABS on a RULER. In the 

picture below , we selected "Set Left Tab" from the Format menu and 

positioned it into place by DRAGGING it over to the 1 inch line on the RULER. 

Note the current position of the cursor (just under the INDENTATION MARK): 

When we press the TAB key the cursor will move directly underneath it: 

Any typing you now do will begin AT THIS TAB MARK . 

Removing Tabs 
A TAB MARK can be removed at any time by simply dragging it off the Ruler 

and letting go of the mouse button. 
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6.0 FILE MANAGEMENT 

Throwing a Document Away 
Just like a real office you can "toss" a DOCUMENT into the TRASH CAN. 

This is done by DRAGGING it directly from a Folder (which is out of the Drawer 

and on the desktop), or you can DRAG a DOCUMENT from the Stationery 

window (but you .Q.aill1Q1 throw away any of the "blank" paper stock) : 

D Rdams, John 

Folder Summary 

As shown above, you find the DOCUMENT you want to get rid of and DRAG 

it down to the TRASH CAN ICON until the ARROW pointer is directly on top of 

the TRASH CAN so that the ICON become s HIGHLIGHTED. When you 

release the mouse button the DOCUMENT will be "dropped" into the TRASH 

CAN and removed from the Folder. The DOCUMENT will remain INSIDE THE 

TRASH CAN until you select "Empty Trash" from the File menu (or if you 

"Quit" the program or "Close" your Cabinet) at which time ALL DOCUMENTS 

inside the TRASH CAN will be "shredded". 

Recovering Documents 
You can recover any DOCUMENTS that haven't yet been destroyed . This is 

done by first DOUBLE-CLICKING on the TRASH CAN ICON which will then 

open up into the "Trash" window: 
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D Trash . - · · 

My Document 

QI 10 

This window will show the DOCUMENTS that are "in the trash". You may 

take a DOCUMENT "out of the trash" by simply DRAGGING it off the window 

and "dropping" it back into a Folder, or onto the Stationery window, or you can 

put it anywhere else on the desktop (screen). 

You may also drag DOCUMENTS Qn1Q the opened Trash window in which 

case they will then be considered as being "in the trash" .alli! subject to 

destruction upon selecting "Empty Trash". When there are numerous DOCU­

MENTS in the TRASH, the SCROLL BAR will become active allowing you to 

view any DOCUMENT ICONS that are not in the currently visible portion of the 

window. As usual, the Trash window can be dragged about the screen or put 

away by clicking in its CLOSE BOX. 

Throwing a Folder Away 
A FOLDER can be "trashed" by DRAGGING IT FROM THE DRAWER 

TO THE TRASH ICON in which case the following message will appear: 

This Folder and RLL OF ITS DOCUMENTS 

will be destroyed foreuer. 

OK~ I Cancel J 

Clicking the "OK" button will destroy the FOLDER forever. Any DOCU­

MENTS "inside" this FOLDER will likewise be instantly "shredded" . Of course, 

you can always change your mind by clicking on the "Cancel" button in which 

case the FOLDER will be returned safely back into its Drawer. 

54 



6.1 Searching for Folders 

When you have many Folders in your Drawer you will want to be able to 

locate them quickly and easily. You can visually SEARCH through a Drawer by 

using the UP or DOWN ARROWS . Clicking on the UP ARROW (shown below) 

will constantly advance the Folders towards the back of the Drawer. Clicking the 

DOWN ARROW will cause the Folders to retreat back towards the front of the 

Drawer. 

You can obtain a continuous "scrolling" by holding down the mouse button. 

In this way you can scan through the Drawer, find the desired Folder, bring it out 

of the Drawer (by double-clicking on it) and begin working with that Folder. 

Finding a Folder 
There is a much faster and more acurate way to locate a specific Folder. 

When you se lect "Find Folder" from the File menu (or press OPEN-APPLE F) 

the following window will appear: 

Find Folder called: 

!Smith! 

[~] [ Cancel ] 

Type in the NAME of the Folder, such as "Smith" shown above, and then 

click on the "OK" button, or press RETURN. A SEARCH for that particular Folder 

Will begin. Clicking "Cancel" will return you back to your Cabinet without 

performing a SEARCH. 
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How the Search Works 
The SEARCH tries to locate the Folder having the same exact NAME as the 

entered "string" and re-displays the Folders in the Drawer STARTING WITH 

THAT FOLDER: 

If the filraQ1 Folder can't be found, the CLOSEST ONE to the search "string" 

will be used. For example, if you type just the letter "S" then the Folders will be 

shown starting with the first one beginning with an "S", or a "T" if no "S" Folders 

exist, etc. The more characters you type, the more precise the search can be. 

You can see the very first Folders in a Drawer by typing a SPACE, an 

ASTERISK or a NUMBER since these characters always come BEFORE 

LETTERS. If you enter "ZZZ" for the search "string", then the Drawer will 

probably appear as "empty" due to the fact that no Folders will exist after "Z". 

Folder Display Position 
When you perform a SEARCH, the starting Folder in the Drawer will always 

remain SET. If you close the Drawer and re-open it, the Folders will again be 

displayed according to the last search "string" used (even if you had "scrolled" the 

Folders before closing the Drawer) . You can change this DISPLAY POSITION 

by entering a different search "string" and executing the search in order to SET it 

to a new Folder. Note that BOTH DRAWERS can be uniquely SET. 
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6.2 The Master List 

The entire 1Q1a!. of Folders in a Cabinet is called the "Master List". The 

"Master List" is, of course, divided into 2 Drawers. The Folders from a Drawer 

can be viewed as a LIST on the screen and can be used for searching with even 

greater precision . Open the top Drawer and then DOUBLE-CLICK on the 

"Master List" ICON: 

The ICON will open up into the "Master List" window: 

;_:ti ·., • ·· , ·". · Master List 

@ Drawer 1 

· Anderson, Bill 
Baker, Thomas 
Carlson , Fred 
Denning, Mike 
Edwards, Lisa 
Frampton, Tina 
Green, Howard 
Hanley, Gary 
Imogene , Harris 
Jenkins, Ann 

Start Display At: 

O Drawer 2 Conditions : D "AND" D "OR" 

Wilson Paper Co 
Front Office Supplies 
Gilden's Furniture 
NowTell Communicati .. 
Pen & Ink Stationers 
Cornwall Plastics 
Green's Chemicals 
Hour by Hour Watches 
First Light Candles 
Harris Clothiers 

945 Elm Aue 
Lakeuiew Mall #4 
319 Chaney Blud 
87 Sycamore Pl 
461 Madiso n Plz 
4th & Oliue St 
57 E Main St #C 

The LIST is displayed in COLUMNS OF FOLDER FIELDS with each 

ROW being a different Folder. You can view the Folders from the bottom Drawer 

by clicking on the "Drawer 2" button at the top left corner of the window. (This 

may only show the single "Adams" Folder you created a few chapters ago). You 

can then view the top Drawer Folders again by clicking on "Drawer 1". 
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Scrolling the List 
Only 10 FOLDERS can be listed on the window at a time, but you can see 

the other FOLDERS by clicking on the UP or DOWN ARROWS (along the 

right edge of the window). or by dragging the "thumb" rectangle (just like the way 

you use the SCROLL BAR with Documents). The RIGHT and LEFT 

ARROWS allow you to scroll and view the other FOLDER FIELDS, as shown 

below . You click the RIGHT ARROW and the FIELDS advance : 

Wilson Paper Co 
Front Office Supplies 
Gilden's Furniture 
NowTell Communicati.. 
Pen & Ink Stationers 
Cornwall Plastics 
Green's Chemicals 
Hour by Hour Watches 
First Light Candles 
Harris Clothiers 

945 Elm AL•e 
La k euiew Mall #4 
319 Chaney Blud 
87 Sycamore Pl 
461 Madison Plz 
4th & Oliue St 
57 £ Main St #C 
733 Oak Portal 

Changing the Column Widths 

Ann Ar bor 
Seattle 
Portland 
Albuquerque 
New York 
Los Angeles 
Saint Paul 

You can adjust the WIDTH of a display COLUMN by pointing to the vertical 

"line" next to its TITLE and DRAGGING it to a new position (as shown in the 

example given below) . Upon releasing the mouse button, the data within the 

COLUMN (and other COLUMNS affected) will conform to the new dimension : 

...-
Name ' ! Company 

r 
Anderson, Bill 
Baker, Thomas 
Carlson, Fred 
Denning, Mike 

Wilson Paper Co 
Front Office Supplies 
Gilden 's Furniture 
NowTell Communicati.. 

If a COLUMN isn't wide enough to display all the characters of a FIELD then 

2 PERIODS " .. " will be shown (such as "NowTell Communications" shown 

above). This tells you that "more follows, but can't be seen". 
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Starting the Display 
The "Start Display At:" box at the bottom of the window allows you to type in 

a "string" to set which Folder you would like the LIST to begin with. This works 

just like "Find Folder" . Type something in and press RETURN to acti vate a 

new DISPLAY. The LIST will then be shown STARTING WITH the entered 

"string". You can also use this to SEARCH for a particular Folder. Enter a name, 

such as "Smith" and this Folder (or closest one) will be the first one displayed. 

Selecting a Folder 
A Folder can be chosen directly from the LIST window by DOUBLE­

CLICKING upon its name or anywhere on the ROW the name is on. (Note that 

holding down the SHIFT key while doubl e-clicking will open the Folder all the 

way to its SUMMARY) . The "Denning, Mike" Folder is shown below being 

selected: 

N 
i C D Denning, Mike 

ame 1 o 

Anderson, Bill 
Baker, Thomas 
Carlson, Fred 
I . 

Edwards, Lisa 
Frampton, Tina 

w 
Fr 
Gi 

! Pe-irv=imi<"na'nom~=:::!:;:=.;::;r=;:;w.iim:;::.l 
i Cornwall Plastics / 461 Madiso1 

The Folder will instantly "fly" out of the Drawer and appear on the screen. 

Using a Folder 
You can then begin to work with the Folder in the usual way by OPENING it 

up (double-clicking on its left half) in order to review or edit the contents of its 

FOLDER SUMMARY. (You might want to first CLOSE the LIST window in 

order to conveniently work with the Folder). Or, you can choose to work with any 

of the Fold er's DOCUMENTS . In this case you can find and OPEN a 

DOCUMENT directly from the Folder by either using the "dog-ears" to "flip" 

through the DOCUMENT ICONS or by OPENING the Folder and choosing 

from the FOLDER LOG inside (double-clicking on a DOCUMENT'S NAME). 
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6.3 "AND" & "OR" Conditions 

You can state certain CONDITIONS that will be used to select specific 

Folders in order to create a CUSTOM LIST . When you click on one of the 

CONDITIONS "boxes" (at the top right of the LIST window), a new window will 

appear which is none other than the left half of a FOLDER SUMMARY: 

D "RND" Conditions 

Name 
I 
Company 

Address 

City I State I Zip Code 

The "AND" CONDITIONS window, partially shown above. is asking you to 

type in CONDITIONS FORMULAS within the FIELDS. These FORMULAS 

will eventually generate a CUSTOM LIST. 

Entering a Formula 
You can TAB through a CONDITIONS window (or use the ARROW keys) 

or click within the desired FIELD and type in the FORMULAS designed to "call 

up" the FOLDERS you want on your LIST . You can think of each FORMULA 

as really being an individual "Find Folder" string. 

Activating the Formulas 
CLOSING the CONDITIONS window will execute the FORMULAS and 

the CHOSEN FOLDERS will appear as a LIST. An active CONDITION will 

always have an "X" check-mark in its "box" on the LIST window or this "box" will 

be "empty" when not being used. You click in the "box" to select a CONDITION 

or click it again to de-select it, and the LIST will be re-displayed accordingly . 
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The "AND" CONDITION 
The "AND" CONDITION stands for "also" or "include the following". The 

way it works is that A FOLDER MUST MATCH EVERY CONDITION 

SPECIFIED in order for that Folder to appear on the LIST. This is like saying "I 

just want this Folder and this one and this one ... " with each "and" being 

another CONDITION. But, this also states which Folders you don't want by 

eliminating the ones that do not match the CONDITIONS. The final LIST will 

therefore be comprised of the resulting SUM OF FOLDERS agreeing with 

EACH AND EVERY CONDITION. 

The "OR" CONDITION 
The "OR" CONDITION stands for "either or" or "choose from the 

following". This is different than the "AND" CONDITION because EACH 

FIELD is considered separately and uniquely. A FOLDER WILL BE 

CHOSEN IF ANY QNE. OF THE CONDITIONS ARE MET. 

This is like saying "I want this folder or that one or that one ... " with each 

".Q[" being a different CONDITION. For example, if you specify an Exact Match 

in one FIELD, and use a Greater Than in another, then the FOLDER might 

be "skipped" from the first FORMULA, but be TRUE for the second and 

therefore added to the LIST. 

ALL CONDITIONS must be met for "AND" , but ANY CONDITION can be 

true for "OR". Of course, if you leave the CONDITIONS completely EMPTY (by 

not entering any FORMULAS), you will obtain a LIST OF ALL FOLDERS! 

Printing using Conditions 
At this time it should be pointed out that you will be using these same 

CONDITIONS to selectively choose which Folders you wish to use for printing 

MAILING LABELS and FORM LETTERS as well as for LISTS both on the 

screen and on paper. Keep this in mind so you can plan ahead. 
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6.4 Conditions Formulas 

Below is a list of the possible CONDITIONS FORMULAS you can use, 

where "XXX" represents the VALUES you will enter: 

Exact Match 

FORMULA 
:XXX 
=(XXX) 
:XXX ... 
<XXX 
>XXX 
<=XXX 
>:XXX 
<>XXX 
<>(XXX) 

MEANING 
Exact Match 
Any Occurrence 
Equals up to given values 
Lesser Than 
Greater Than 
Lesser Than or Equal To 
Greater Than or Equal To 
Not Equal To 
Not Equal To Any Occurrence 

The Exact Match FORMULA will select~ those FOLDERS that have 

the same exact "string" in the same FIELD as on the CONDITIONS window. 

For example, to obtain a LIST of everyone in Los Angeles you could use: 

I city 
~Los Angeles 

(Upper and lower case letters are always treated as being EQUAL). 

IMPORTANT NOTE: You cannot use COMMAS within the statement or 

else you will be setting MULTIPLE CONDITIONS (as explained shortly). 

Any Occurrence 
The Any Occurrence FORMULA will select all Folders having the entered 

value anywhere in the given FIELD . As an example using "Smith", you could 

create a LIST containing "Smith", "Smithsonian", "Longsmithson". and 

"Blacksmith" since they all in fact contain the letters "S-M-1-T-H": 

I Name 
~(Smith) 
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Equals Up To ... 
The "Equals up to ... " FORMULA chooses Folders that at least match the 

"string" up to the amount of characters entered. If you use "=Smith ... " then you 

wou ld still have "Smith " and "Smithsonian, but not "Longsmithson " nor 

"Blacksmith" because they do not begin with "SMITH". 

Lesser Than 
The Lesser Than FORMULA allows you to selec t Folders whic h have a 

VALUE that is Lesser Than the one entered on the corresponding FIELD of 

the CONDITIONS window. The following examp le wi ll generate a LIST of all 

Folders that have a "Zi p Code" below 20000 : 

I Zip Code 
. <2 0000 

You QQ..!J.1 have to use numbers. You can also say "<K" to obtain a LIST of all 

names coming before "K". This yields a LIST having a range of "A" through "J". 

Greater Than 
You could use the Greater Than FORMULA to obtain ALL ZIP CODES 

ABOVE 90000 : 
Zip Code 
>9 0000 

The result will be a LIST of just those Folders that have a number above 

90000 in their "Zip Code " FIELDS . However, 90000 itself will not be included, 

so in order to also have 90000 on the LIST you wou ld need to modify the 

FORMULA to ">89999" . 

Lesser (or Greater) Than or Equal To 

With the add ition of an "=" Equals sign in the FORMULA you can use the 

"Lesser Than" or "Greater Than" FORMULAS to also INCLUDE THE 

ENTERED VALUE as well as the ones below or above it. 
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~ .. .. .. 
Not Equal To ._ 

The Not Equal To FORMULA will select a Folder if in fact the data in the .._ 

given FOLDER FIELD does IlQ1 match the entered VALUE. The Not Equal ._ 

To Any Occurrence is the same but with the additional function of examining a ._ 

FIELD for Any Occurrence of the entered VALUE . S-
91m 

Combining Formulas ... 
You may COMBINE FORUMLAS into the same FIELD by separating each ... 

one with a COMMA. In this way a RANGE can be obtained: 

Zip Code 
>20000,<30000 

All FOLDERS that have a number in the "Zip Code" FIELD Greater Than 

20000 and Less Than 30000 will be added to the LIST . Using the "AND " 

CONDITIONS, any "Zip Codes" falling outside this RANGE will IlQ1 appear on 

the LIST. However, the "OR" CONDITIONS will select a Folder if EITHER 

VALUE is tru.e. (therefore ALL FOLDERS would essentially be chosen!) . 

Multiple Conditions 
You can use multiple CONDITIONS by putting FORMULAS into more than 

one FIELD . In the next example we are asking for "all Smiths that work at 

Acme Parts Co": 
Name 
=(SMITH) 

Company 
=Rcme Parts Co 

Using the "AND" CONDITIONS , a FOLDER will be chosen ~ if the 

"Name" FIELD contains "S-M-1-T-H" and the "Company" FIELD has "ACME 

PARTS CO" Exactly , otherwise the Folder will be ignored. However, using the 

"OR" CONDITIONS, EITHER ONE can be 1.r..!.!& for a Folder to be LISTED 

(and you will obviously get everyone else from "Acme Parts Co" as well as 

~ "Smith" Folder no matter what is in their "Company" FIELDS). 
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6.5 The Indexes 

The MASTER LIST can be broken down into 2 more LISTS that are called 

INDEXES . You can think of an INDEX as being just like those found at a library. 

Ther e is usually a box containing index cards where each card represents a 

book and is filed in alphabetical order according to its title. To find the book you 

want you would look through these index cards until you locate its title (which is 

just like "thumbing" through your Drawer or using "Find Folder") . 

But, a library often offers other INDEXES comprised of cards representing 

certain SUBJECTS . For example, one type of INDEX might have cards for all 

books under the category of "AUTO REPAIR ". You can find books either by 

going to the "master " index box containing a card for each and every book, or go 

to the "category" box containing just those books within a specific subject. 

Notes •n• Files allows you to create 2 different types of "categories " that 

can be customized in order to obtain a special LIST OF FOLDERS . Whereas 

the MASTER LIST will display ALL FOLDERS in a Drawer, an INDEX can be 

setup to show you~ certain ones and display them in assorted ways. 

Selecting an Index 
Put away the LIST window, open the top Drawer and click on the "Index 1" 

ICON at the bottom of the desktop: 

Upon doing so the "Index 1" ICON will become HIGHLIGHTED (meaning it 

is the current selection) and the Folders will be shown in the Drawer a different 

way, as dictated by this INDEX. In the following example we see that the Folders 

are displayed by "Company" rather than by "Name": 
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This particular INDEX was setup as a sample to show just those Folders 

that have something in their "Company" FIELDS. If you now click on the 

"Master List" ICON, the FOLDERS will revert to being displayed by "Name" . 

The Index List Window 
Once you have selected an INDEX you can then view its LIST window. Do 

this now by DOUBLE-CLICKING on the "Index 1" ICON and it will open up 

into the "Index 1" window: 

Company ! Name · · . · I · : 1 
. . 

Action Rentals 
AECO Leasing 
Better Machines 
Cornwall Plastics 
CPA Specialties 
First Light Candles 
First National 
Front Office Supplie .. 
Gilden's Furniture 
Green's Chemicals 

Lewis, Rob 
Parker, Peter 
Richardson, Arthur 
Frampton, Tina 
Tanner, Luke 
Imogene, Harris 
Kendall, Mary 
Baker, Thomas 
Carlson, Fred 
Green, Howard 

Notice how the "Company" FIELD is shown in the first column (on the left) 

and that it is in ALPHABETICAL ORDER. The "Name" is now the second 

column and the third column isn't used at all. This is because we configured the 

INDEX 1 LIST that way, but you can change this at any time to your own liking. 
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Creating an Index 
Unlike the MASTER LIST, the Index window has an extra button at the 

bottom right corner called "Setup": 

~~ 
Clicking on this "Setup" button will bring up a new window on the screen: 

Column Selection: 

Field Selection: 

1¢1 tml:$MU!s>I 
Field Sort Type: 

@ A to Z 

0 Z to A 

[ OK ] 

lndeH 1 Setup 

0 Oto 9 
O 9 to O 

0 Jan to Dec 

O Dec to Jan 

Selecting a Field 

( Cancel ) 

The SETUP window allows you to choose which COLUMNS you wish to use 

to show the FOLDER FIELDS. You select the COLUMN you want to set and 

then select a FIELD for that particular COLUMN. 

IMPORTANT NOTE: The very first COLUMN will be used to determ ine 

how the LIST will be SORTED in the Drawer (and how a FOLDER will be filed 

when Saved, as we shall soon learn). 

In the next example we are selecting the second COLUMN (by clicking on it) 

which is currently using the "Name" FIELD: 
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This FIELD can be changed by using the "FIELD SELECTION" ARROWS: 

Column Selection : 

• ..., ........... ,_._._.,;,_....._.,,..,,_.,...,.;;.~~ •. ~;.,'J_,,_..,.,,_._._._.} .. _.,.,.,.,..,,,,,:.;:,...'J...,.,11.•;,,,,.,,,,.,.~:.~_..,..,»J.'~J:'.,,n.•;;,;:_. • .,,,.,;;;; 

For example, by clicking 3 times on the RIGHT ARROW you will see the 

COLUMN TITLE change to "City". Or, you can continue to click eithe r the 

RIGHT or LEFT ARROWS (or drag the white "thumb") in order to "fly" through 

the FIELDS until you see the NAME of the FIELD you want to use for this 

particular COLUMN. 

The other COLUMNS are chosen in a similar manner. Click on the 

COLUMN (header) and then select the desired FIELD using the ARROWS. 

The (none) Column 
A COLUMN titled "(none)" means NO FIELD has been chosen for it yet. 

However, this also means that THIS COLUMN AND ALL COLUMNS 

THEREAFTER to the right of it will be ignored and not included in the INDEX 

generation. In fact, if the very first COLUMN of an INDEX is set to "(none}" , 

then the INDEX will become, of course, completely EMPTY . 

Field Sort Types 
The "radio" buttons near the bottom of the Index Setup window allow you to 

SORT the COLUMNS of an INDEX in various ways. A "Field Sort Type" 

button is chosen by simply clicking in it. You can choose any one of these buttons 

for EACH COLUMN, thereby allowing you to obtain different kinds of SORTS. 
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Whenever you click on a FIELD COLUMN, the corresponding SORT 

button chosen for that particular FIELD will be shown "filled in". The DEFAULT 

SORT TYPE for every COLUMN is "A to Z", but you can change this to a 

different TYPE by first clicking on the COLUMN, then clicking on the button. 

Field Sort Buttons 
The buttons "A to Z" and "Z to A" allow you to create an INDEX that will be 

displayed in either ASCENDING ALPHABETICAL ORDER of "A", then "B", 

then "C", etc., or in DESCENDING ORDER of "Z", then "Y", then "X", etc. This is 

most often and best used on the very FIRST COLUMN (whic h is how we 

obtained our "Companies" in alphabetical order). 

The buttons "O to 9" and "9 to O" work the same way but will result in an 

INDEX LIST displayed in NUMERICAL ORDER. This is ideal for creat ing ZIP 

CODE SORTS for printing MAILING LABELS. In this case, always ensure the 

"Zip Code" is the FIRST COLUMN of the INDEX LIST . (Note that to correctly 

sort an "Address" COLUMN you should use "A to Z" because an ADDRESS 

contains LETTERS in the STREET NAME). 

"Jan to Dec" and "Dec to Jan" allow you to SORT BY DATE . This will 

display the FOLDERS in the order of JANUARY THROUGH DECEMBER tor 

each year, or in the reverse order of DECEMBER TO JANUARY . 

Date Format 
If you intend to use a DATE then it must be entered in a FOLDER FIELD 

using the specific FORMAT of 1/1/87 or 01/01/87 (for January 1, 1987). 

Otherwise, the display SORT may not come out correctly. The order of the 

MONTH/DAY/YEAR depends entirely upon your CONTROL PANEL 

SETTING . FOREIGN DATE FORMATS can be obtained by reve rsing the 

MONTH and DAY on the CONTROL PANEL CLOCK (press the 3 keys 

OPEN-APPLE, CONTROL and ESCAPE simu ltaneousl y). 
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Generating an Index 
The COLUMNS, FIELDS and SORT TYPES are automatically Saved 

when you click the "OK" button (bottom left corner of the Index Setup window). 

Clicking "Cancel" will ignore any changes you might have made and will return 

you back to the unaltered INDEX LIST window. 

When you click "OK", the FOLDER DATA from the ENTIRE MASTER 

LIST will be scanned and a NEW INDEX WILL BE GENERATED according 

to the COLUMNS, FIELDS and SORT TYPES selected. This could take 

several moments for a Cabinet containing many FOLDERS . You will then be 

shown the new LIST on the INDEX window (ao..ct. according to any CONDI­

TIONS you may have set), or if you CLOSE the window you will then see the 

Folders in the Drawer ACCORDING TO THIS INDEX. 

Adding New Folders 
Whenever you make a NEW FOLDER and Save it. not only will it be 

entered into the MASTER LIST as usual, but it will also be FILED INTO THE 

OTHER 2 INDEXES ! The Folder will be automatically placed in ALPHA­

BETICAL ORDER according to the very FIRST COLUMN of the INDEX . 

However, the Folder MUST HAVE DATA IN THE FIELD selected as the 

FIRST COLUMN or else it will not be included in an INDEX. 

Index Conditions 
When you have an INDEX LIST window up on the screen and you select the 

"ANO" or "OR" CONDITIONS, you will notice that~ the chosen FIELDS for 

th~ INDEX will be active on the CONDITIONS window. But, you enter your 

FORMULAS into these FIELDS in the usual way. 

Since both "custom" INDEXES can make use of their own CONDITIONS, a 

great variety of LISTS can be generated both on the screen as well as on paper 

and changed at will at any time. 
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7.0 PRINTING 

You can PRINT a DOCUMENT by simply DRAGGING IT FROM A 

FOLDER down to the COPIER and "dropping" it in: 

D Rdams, John 

Folder Summary 

I Copier I 

You may a lso drag a DOCUMENT from the Stationery window, or right off 

the desktop . Upon releasing the mouse button, the COPIER window will appear : 

Printer : Quality: 

O lmageWriter O Draft 
@ lmageWriter 11 @ Standard 
O LaserWriter O High 
O DaisyWheel 

D Page Numbers D Single Sheet 

Margin: mJ Copies : rr=J Range: ! I -END j 

[ OK ] ( Cancel ) 

Copier Panel 
This window is like the "panel" on a copier machine . You can select various 

options concerning the printing, such as the type of quality , number of copies, 

etc. The COPIER window will be presented to you ~ time you want to print 

something, just prior to the actual printing activity. 
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Printing Options 
Select the PRINTER you will be using by clicking in its "radio" button. Let's 

take a moment here to examine the differences in printers . The lmageWriter ™ 

and lmageWriter II™ are dot-matrix printers and this means they can print 

characters in the form of tiny individual "dots" and therefore can reproduce all of 

the fancy FONTS and STYLES you typed with on your DOCUMENT . The 

LaserWriter ™ prints using many times more "dots" for each character resulting 

in an ultra-fine resolution suitable for book or magazine quality print. A Daisy­

w heel printer is most commonly used for letter quality printing. It is different 

than dot-matrix printers because it uses a wheel comprised of a "molded" 

character set that strikes the ribbon in order to print each character, just like a 

typew riter. Therefo re, the Daisy-wheel is incapable of printing the differe nt 

FONTS and STYLES and can~ print using the DRAFT mode quality. 

Howeve r, you can obtain and use different types of wheels and manually switch 

them in order to print characters of different sizes and styles. 

You also select the QUALITY by clicking in one of the buttons. STANDARD 

is the most common choice as it prints your DOCUMENT just as it appeared on 

the screen , with all your FONT SIZES and STYLES. HIGH QUALITY prints in 

a similar fashion but uses a "double-pass" printing resulting in a much sharper 

print -out (but takes somewhat longer to accomp lish). DRAFT is very different 

than STANDARD or HIGH. Even thou gh you may have typed your 

DOCUMENT using different FONT SIZES and STYLES, the DRAFT printin g 

mode cannot reproduce any of them. The printing will always result in the same 

size characters. 

The PAGE NUMBERS "box" will show an "X" check- mark when clicked and 

will represent the fact that it has been selected. Thi s will print the PAGE 

NUMBER centered at the bottom of EACH PAGE of the DOCUMENT . 

Clicking the "box" a second time will remove the "X" and de-select this option so 

that the PAGE NUMBERS will .D.Q! be added during printing . 
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The SINGLE SHEET button is likewise chosen by clicking in it. This is for 

manually feeding ~ piece of PAPER during printing (when asked to do so). 

Normally you would use "form-feed" paper, but by choosing SINGLE SHEET 

you can use your own pre-printed letterhead stationery. 

The LEFT MARGIN can be entered by editing the "Margin " box. This is 

"how far from the left edge of the paper" (expressed in INCHES up to 3 

decimals) you want the printing to begin. This value is in addition to the LEFT 

MARGIN your DOCUMENT is using. Of course, you can manually adjust the 

physical position of the paper in the printer to obtain a different LEFT MARGIN. 

You can then either TAB over to the "Copies" or "Range" boxes, or you can 

click within these boxes to edit them. The number of COPIES you wish to print of 

your DOCUMENT can be changed by entering the amount into the "Copies" 

box. This will be the number of SETS (as opposed to individual multiple pages). 

The RANGE "box" allows you to print specific PAGES of your DOCUMENT. 

For example, typing in "3-5" will print a RANGE of PAGES 3 THROUGH 5. 

Entering "3-END" will~ the printing at PAGE 3 and continue on through all 

the rest of the PAGES of the DOCUMENT until its ~- (If more than one 

COPY has been chosen, the next "round" will then begin printing). 

Start Printing 
Once the COPIER window has appeared on the screen and you have 

selected the desired parameters, clicking "OK" or pressing RETURN will accept 

and save these settings and then the actual PRINTING will begin. Clicking 

"Cancel" instead will put away the COPIER window and, of course, no printing 

will occur. 

You can ABORT the printing process at any time by pressing the ESCAPE 

key (upper left corner on your keyboard). 
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Printing Technical Info 
It should be pointed out that what you see on the GS SCREEN is not always 

equal to what you will get on your printed paper. The reason for this is that the 

vertical screen dimension and the ImageWriter's vertical printing distance are 

not the same. 

However, Notes •n• Files uses a unique "scheme" to compensate for their 

differences. This is accomplished by "blowing up" a DOCUMENT on the screen 

so that its vertical length is DOUBLED. Then, upon printing, Notes •n• Files 

"shrinks" each page down to its correct size. Even though the FONTS you use 

may seem somewhat large on the screen, they will be reduced during printing 

which will result in a far superior print than if the FONTS were printed according 

to their "screen size". 

Control Panel 
If you are having any printing trouble then you should verify the CONTROL 

PANEL SETTINGS . Press the 3 keys OPEN-APPLE, CONTROL and 

ESCAPE simultaneously and then go into the "Printer Port" section. Every item 

except "Add LF after CR:" should be .,/check -marked for these are the 

recommended PRINTING DE FAUL TS that should be used. 

IMPORTANT NOTE: The "Add LF after CR:" .!JlU.fil be set to "NO" . This 

setting is for whether or not to send a LINE-FEED to your printer after a 

CARRIAGE RETURN. If set to "YES" the paper will advance in your printer a 

little bit at the end of each printed line and this will add, of course, a BLANK 

LINE between every line. You could also have some "trouble" printing in the 

HIGH quality mode since the "second pass" might be printed on the next line. 

Therefore, if "Add LF after CR:" is .,/check ed then you .!JlU.fil un-check it (by 

using the ARROW keys). After doing so, press RETURN to "save" this change 

and then you should RE-BOOT the computer (by turning it completely off, then 

on) and re-enter Notes •n• Files to resume printing. 
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7.1 Printing Documents 

Printing an Open Document 
When you have a DOCUMENT open on the screen you can print it by 

selecting "Print Document" from the Print menu (or press OPEN-APPLE P}: 

Upon doing so you will be presented with the COPIER window and you can 

proceed to print the DOCUMENT by selecting the desired parameters and 
clicking the "OK" button or pressing _RETURN. · 

In this way you can print the DOCUMENT you are currently working on at 

any time. You could also take an older DOCUMENT and open it up, make some 

changes to it, if you wish, then print this altered DOCUMENT and put it away 

without even Saving the changes (as the original remains intact}. 

Printing a Window --. The currently active WINDOW (the one in lliill1 of all others} can be printed 

by selecting "Print Window" from the Print menu (OPEN-APPLE W}. You will 

then reach the COPIER and you can proceed as usual. You can use "Print 

Window" to print a FOLDER SUMMARY screen or a single DOCUMENT 

PAGE or even the INDEX LIST or CONDITIONS WINDOWS . However, this 

will n.Q1 print the entire LOG of the SUMMARY , nor all the pages of your 

DOCUMENT, nor the complete INDEX LIST. It will merely print the current 

window JUST AS YOU SEE IT on the screen. 

NOTE : Because the WINDOW cannot be printed in the DRAFT mode you 

cannot use a Daisy-Wheel printer for this feature. 
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7.2 Mailing Labels 

In order to print LABELS , first make sure you 1) CLOSE ALL OPEN 

WINDOWS (so the screen is virtually empty), then 2) OPEN THE DRAWER 

you want to print from , or CLOSE THEM BOTH to print the entire Cabinet. 

Select "Mailing Labels " from the Print menu and this window will appear: 

Use lndeH : 
@ Master List O lndeH 1 O lndeH 2 [[ Start J] 

cancel 
Use Conditions : D "AND" D " OR" 

Flag Folder: D Yes 

Lobel Format: 

Label Row: 
@ One Lobel O Two Across O Three Across 

Dimensions : 

f4i ! Inches Across ~11_.o_~ ! Inches Down ( Trial Print ) 

Selecting Folders 
You will need to tell Notes •n• Files which FOLDERS you want to use for 

printing your LABELS. Using the MASTER LIST you can print fill of the Folders 

from the ENTIRE CABINET IF BOTH DRAWERS ARE CLOSED, or you 

can print just the Folders from the CURRENTLY OPENED DRAWER. 

Of course, choosing one of the "custom" INDEXES will limit the print ing to 

just those FOLDERS generated by the INDEX . 
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You may also choose to FILTER which Folders will be selected for printing 

by clicking either the "AND" CONDITIONS or the "OR" CONDITIONS, or you 

can use both of them. Notes •n• Files will then use the ~ Folders as the 

ones generated by their FORMULAS. Needless to say, the CONDITIONS 

FORMULAS .!I!...!.!.fil be entered and executed PRIOR to bringing up the 

LABELS window. 

Label Format 
The middle section of the LABELS window allows you choose which type of 

printing FORMAT you would like to use for a LABEL. The desired FORMAT is 

chosen by simply clicking in its "rectangle", as shown below: 

The chosen FORMAT will print each LABEL using the exact FOLDER 

FIELDS that you see on this window. It won't matter if you have RE-NAMED 

these FIELDS because a LABEL will always be printed using the first 6 
FIELDS of a FOLDER SUMMARY. 

Note that if the "Name" FIELD (the FIRST FIELD of a FOLDER SUM­

MARY) contains a COMMA, then the data will be REVERSED. For example, 

"Adams, John" will be turned into "John Adams". For this reason, the FIRST 

FIELD of a FOLDER SUMMARY should always be reserved for NAMES 2.!Jh'._. 

Label Row 
You can choose the NUMBER OF LABELS ACROSS the page for your 

Label paper. This is done by simply clicking in the appropriate button. Various 

kinds of Label paper are available at your local Stationery store and it is entirely 

up to you which type of paper you will want to use. 
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Label Dimensions 
The physical DIMENSIONS of a LABEL can be entered by editing the 2 

"boxes" at the bottom of the window. You will be typing in the exact distance from 

one LABEL to the next which will basically tell Notes •n• Files WHERE to print 

each LABEL on your paper . 

The first "box" is for the DISTANCE ACROSS the page from LABEL TO 

LABEL. The entered value must be expressed in INCHES (up to 3 decimals) . 

This is meaningle ss, of course, if you are choosing only "One Label" across . 

The second "box" (which can be edited by either TABBING over to it or by 

clicking within the "box") is for the DISTANCE DOWN the page from one ROW 

OF LABELS to the NEXT ROW, again expressed in INCHES . 

NOTE : LABELS are always printed using the DRAFT QUALITY . This will 

print 15 characters per inch horizontally and 6 lines per inch vertically . 

Trial Print 
"Trial Print" is for running a TEST printing of your LABELS that will print 2 

"dummy" sets with lines of "XXX's". This allows you to see how they will turn out 

(so you won't waste too much paper if the parameters are incorrect). Clicking the 

button will first present the familiar COPIER window and then you can START 

the TEST by clicking "OK" or pressing RETURN . You can continue making any 

needed adjustments and running the TEST until satisfied. It is a common 

practic e to use "regular" paper for the TESTS and your "good" LABEL STOCK 

for the final printouts. 

The Copier 
To begin the actual printing of your MAILING LABELS you click Qn the 

"START" button at the top right corner of the LABELS window . Clicking the 

"Cancel" button instead will return you back to your Cabinet (without Saving 

any of the LABEL parameters you may have changed). 
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When you either START the printing, or run the TEST, you will always be 

given the COPIER window, as shown on page 71, before the actual printing 

occurs. You can choose the PRINTER you will be using, but only the DRAFT 

mode will be ACTIVE at this time. The PAGE NUMBERS and RANGE buttons 

will also become INACTIVE since they do not apply to LABEL printing. 

Left Margin 
The MARGIN is Yfil:i.. important to you because this is the distance of HOW 

FAR FROM THE LEFT EDGE OF THE PAPER THE FIRST LABEL WILL 

BE PRINTED. As usual, this is expressed in INCHES (up to 3 decimals). Notes 

•n• Files needs to know this value in order to position and print the LABELS 

correctly on your paper. Of course, you may also adjust the LEFT MARGIN by 

manually shifting the paper in the printer. 

Copies 
The number of COPIES can be chosen by editing its "box". This will be the 

NUMBER OF SETS OF LABELS you wish to print. A "SET" is defined as the 

"complete list" generated by the chosen INDEX. If, for example, you enter "3", 

then Notes •n• Files will print ONE COMPLETE SET OF LABELS, then 

print the second SET and then the third, as opposed to printing 3 of the first 

LABEL, then 3 of the second LABEL, and so forth. 

The Final Labels Printout 
When the printing process begins, Notes •n• Files finds and selects a 

Folder for printing (according to the INDEX . and CONDITIONS you have 

chosen), gets the data from its FOLDER FIELDS and forms a printable 

LABEL, positions it on the paper (depending on the dimensions you entered) 

and then the LABEL is finally printed. The next Folder is obtained and the above 

procedure is repeated. 

You can ABORT the printing at any time by pressing the ESCAPE key. 
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7.3 Form Letters 

Notes •n• Files has a built-in MAIL MERGE capability . This means it can 

take the names and addresses from your Folders and ~ them into your 

LETTERS to create a personalized "heading" for each one printed. 

Creating a Form Letter 
A FORM LETTER is a "master" DOCUMENT that can be used to print 

consecutive copies. It is a special type of DOCUMENT because it uses a unique 

way of telling Notes •n• Files to insert FOLDER FIELD DATA INTO THE 

LETTER during print ing. 

You create a FORM LETTER by bringing up a new DOCUMENT (or a 

previously created one) and then typing out your LETTER. Wherever you would 

like the MERGE to take place on the DOCUMENT you will type in the 

FOLDER FIELD :r1TLE SURROUNDED BY BRACES . For example, to 

create a HEADING of name and address you would use the following notation: 

{Name} 

{Address} 

{City}, {State} {Zip Code} 

You put BRACES around the FOLDER FIELD TITLE, spelling it exactly as 

shown on the SUMMARY window. In the above example, notice how we typed a 

COMMA after {City}. The COMMA , being outside the BRACES, will be printed 

right after the CITY , followed by a SPACE , then the STATE, another SPACE 

and then the ZIP CODE. 

When you print this DOCUMENT , the FOLDER DATA will be taken from 

the corresponding FIELDS and "merged" into the LETTER as follows: 
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Adams, John 

123 Main St. 

Los Angeles, CA 90028 

Reversing the Name 
You can REVERSE the first and last name by INCLUDING A COMMA 

within the BRACES. The above example would then become: 

{,Name} {Name,} 

This means "print the Name from the comma on, then print the Name 

1Q the comma". Note that there is a SPACE between the 2 expressions . The 

name "Adams, John" will be examined and then re-formed by using "John" for 

the expression "{,Name}" and "Adams" for "{Name,}". This example will then 

print as: 

John Adams 

It is important to keep this in mind when entering a NAME into a Folder. For 

example, if you use "John Adams, Ill" then the above notation would result in 

"Ill John Adams". You see, the correct entry should be "Adams Ill, John ". 

Salutations 
Another common usage for the above notation is to create a SALUTATION. 

For example , you could use the "FROM THE COMMA ON" notation and type a 

COMMA af1fil the second BRACE: 

Dear {,Name}, 

The above notation would then be printed as: 

Dear John, 
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Merging Folder Data 
Not only can you use any of the FOLDER FIELDS, but you may also place 

them at .an¥. point within your DOCUMENT. This leads to some interesting 

effects . For example, you could say "So, how is the weather in {City}?" 

(Notice that the "?" is typed outside the BRACES ). When printed this would 

become: 
So, how's the weather in Los Angeles? 

Custom Fields 
You could RE-NAME a "Misc." FIELD to something like "Amount Owed" 

and dedicate this FIELD for holding dollar amounts. Then in your LETTER 

you can say: 

Seems like you still owe us {Amount Owed} . 

When the above is printed, the data from the "Amount Owed" FIELD will be 

inserted into the DOCUMENT. However , should the merged DATA be fairly 

long in length, the sentence will be adjusted by "wrapping" to the next line, if 

necessary, and will appear just as if you typed the data in by hand. 

Saving the Form Letter 
When you have completed your FORM LETTER MASTER, you would then 

Save it as a DOCUMENT in the usual manner. However , in order to file it 

properly you should always bring a Folder out of the Drawer~ making and 

Saving the LETTER . 

You might even want to create a new FOLDER just to hold all of your FORM 

LETTER MASTERS so that you can find them quickly when needed. In this 

case, if you plan on printing a LETTER to fillm Folder, then this particular 

FOLDER will need to be FIL TE RED OUT (by using the Does Not Equ al 

FORMULA) or else it will be included in the actual printing! 
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One-Shot Form Letter 
You can DRAG a FORM LETTER through the COPIER and it will use the 

FOLDER it is coming from for the MERGE . Or, if the DOCUMENT is coming 

fro m the Stationery window then it will use the FRONTMOST FOLDER on 

the desktop. If there is no Folder at all, then NO MERGE will take place and. the 

BRACES will be literally printed! 

Selec ti ng the Form Letter 
The best way to print a FORM LETTER is to 1) CLOSE ALL WINDOWS 

and 2) OPEN THE DRAWER you wish to print from, or close them both to use 

the ENTIRE CABINET . 3) SELECT the DOCUMENT by clicking once on it in 

orde r to HIGHLIGHT it and then 4) select "Form Letters" from the Print 

menu. If you don't se lect a FORM LETTER ; Notes •n• Files will tell you that it 

cannot continue until you do so. 

In the following example, we have SELECTED a FORM LETTER that is 

inside a Folder, and then we pull down the Print menu: 

Prin1 llliruh>W 

Folder Summary !SJ 

This will bring up the following window: 

Use lnde ft: 
@ Master list O lndeH 1 O lnd eH 2 [[ Start ]] 

Use Conditions : D "AND" D "DR" 

Flag Folder: D Yes 
Cancel 

Mail Merge Document : My Form Letter 

83 



You can select the INDEX you will be using as well any CONDITIONS in 

order to print certain FOLDERS . Needless to say, the CONDITIONS must be 

set up PRIOR to starting the FORM LETTER process. 

Start Printing 
After setting the desired parameters on the FORM LETTERS window you 

can then begin printing by clicking on the "START" button, or you can choose to 

"Cancel" which will Close the window and return you back to your Cabinet. 

Upon STARTING, you will be presented with the familiar COPIER window . 

As usual, you choose which PRINTER you will be using, but this time the 

QUALITY buttons will become fully active. Choosing "DRAFT" will print the 

DOCUMENT just like a typewriter would, that is, without using any FONTS. 

"STANDARD" or "HIGH QUALITY" will print the DOCUMENT with all of the 

different FONTS and STYLES you typed with. "HIGH QUALITY" will yield a 

finer printed DOCUMENT than with "STANDARD", but it does take a few 

moments longer to accomplish this "double-pass" printing method. 

You can include PAGE NUMBERS if you desire. Selecting SINGLE 

SHEET allows you to use your pre-printed LETTERHEAD stationery . The 

LEFT MARGIN can also be set at this time, along with the number of COPIES 

(SETS) as well as the RANGE. These are all explained earlier in this chapter. 

Printing the Form Letter 
Clicking "OK" will begin the printing process. Clicking "Cancel" will take you 

back to the FORM LETTERS window. Upon STARTING the printer, Notes 

•n• Files will scan your MASTER FORM LETTER and insert the FOLDER 

FIELD DATA from~ FOLDER for~ LETTER printed, according to the 

BRACES NOTATIONS you have chosen. 

You can ABORT the printing at any time by pressing the ESCAPE key. 
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7 .4 Flagging a Folder 

Notes •n• Files allows you to "flag" a FOLDER when it has been used for 

printing MAILING LABELS or FORM LETTERS . This is done by literally 

RECORDING the fact that printing has occurred by writing today's data back to 

each Folder. Through the use of these ''flags" you can always know "what's 

been printed when" . 

Setting a Flag 
FLAGGING is set for either LABELS or FORM LETTERS by clicking the 

"Flag Folder" button : 
Use lndeH: 

@ Moster List O lnde 

Use Conditions: D "RND" 

Flog Folder: ~ Yes 

An "X" check-mark will always mean "YES, FLAG THE FOLDER" while an 

"empty" box will mean "NO, DON'T DO IT". 

Updating a Folder 
When the printing process begins, ~ FOLDER printed will have 

TODAY'S DATE WRITTEN BACK to its Folder Summary. This FLAG DATE 

will always be placed in SPECIFIC FIELDS on the Summary. The "Labels" 

FIELD will be used for LABELS and the "Letters" FIELD will be used for 

FORM LETTERS : 

Misc. 1 Misc. 2 

Misc . 3 I Misc. 4 Lobels I Letters 
01/01/87 01/01 / 87 

1' 1' 
Lobel write-bock Form Letter write-bock 
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IMPORTANT NOTE : The DATE will REPLACE any data currently in these 

FIELDS so if you intend to use this FLAGGING feature, then you must reseNe 

these 2 FIELDS accordingly . Furthermore, you should D..Q1 enter important data 

into them by hand, but let Notes •n• Files FLAG them for you. 

You m..ay_ RE-NAME these FLAG FIELDS as desired. 

Using Flagged Folders 
The reason for FLAGGING FOLDERS is so you can always know which 

Folders have been used for printing. Once your Folders have been FLAGGED 

you can thereafter do many special things with them. 

For example, you can print part of a Drawer this week and FLAG the DATE 

for these Folders. Then, next week you can select the remaining Folders yet to 

be printed by specifying a CONDITION relating to the DATE of the FLAG 

FIELD . Let's say you did the first printing on March 4, 1987. You could then 

enter the FORMULA: 
Labels 
<>03/04/87 

which would, of course , select all Folders Not Equal To the entered DA TE 

thus coming up with all of the unprinted Folders! 
. 

As another example, let's say you print and send a LETTER to certain 

people and FLAG TODAY'S DATE on each Folder to indicate the fact that 

they have been mailed something. Then, if you receive a response, such as a 

phone call or a return letter, you can go into their Folders and erase the DATE 

that was written -back to the FLAG FIELD . Then next month you can mail a 

second letter to those Folders still having the DATE (meaning these people 

haven't responded yet) by entering an Exact Match FORMULA such as 

"=03/04/87" . This would select just those Folders having March 4, 1987 in the 

FLAG FIELD . 
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7.5 Printing Lists 

Whenever you have an INDEX LIST window open on the screen you can 

print a "line by line" LISTING of these Folders by selecting "Print List" from the 

Print menu: 

Upon doing so you will be shown the COPIER window. As usual, clicking 

"OK" wi ll begin printing the LISTING (and pressing ESCAPE will ABORT the 

process at any time). Note that DRAFT is the only allowable printing mode. The 

lmageWriter will print in the condensed mode of 15 characters per inch. 

Using an Index 
The printing will be the same LIST OF FOLDERS as that generated on the 

LIST window. You can print the full MASTER LIST or use an INDEX (in which 

case you will need to set up your INDEX FIELDS Im.QI to printing). The 

CONDITIONS can also be used to generate various combinations of Folders 

for your LISTINGS . You enter your FORMULAS in order to obtain a LISTING 

on the screen and then , when ready, you select "Print List" and proceed to print 

the LIST on paper. 

About the Listing 
A HEADER will be printed on ~ page that will be formed using the 

TITLES of the FOLDER FIELDS being used. This will be followed by 3 

COLUMNS of data on each line until ALL FIELDS have been printed. These 

COLUMNS will have fixed POSITIONS on the paper. However, you can 

"customize" your LISTING by preparing an INDEX either by adding or 

removing FIELDS, or by switching the FIELDS around prior to printing. 
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8.0 Special Applications 

The number of ways to use Notes •n• Files is almost endless. By creat ing 

individual Cabinets and using the INDEX CONDITIONS you can come up with 

very imaginative ways for manipulating your data. 

The following examples are only just a few of the things you can do with 

Notes •n• Files. There are many other ways to use Notes •n• Files and the 

following suggestions are given here merely to get you thinking as to how you 

can apply Notes •n• Files to your own particular system. By all means you 

should sit down and think about what you really want to do, develop a plan, then 

after studying the manual and trying a few things with the program you can take 

your creative ideas and begin putting them to practical use. 

Mail House 
Perhaps the most common usage of Notes •n• Files will be for what we call 

a "Mail House" . This is nothing more than a data base used for generating 

MAILING LABELS. It is a very simple SYSTEM . You create a Cabinet and call 

it something like "Addresso" or "Clients" or even "LABELS DATA". Nothing 

really fancy, you see, a plain Cabinet that contains NAMES & ADDRESSES . 

You create a FOLDER for each and every person for whom you have an 

address. Because the FOLDER SUMMARY will contain Q.OJy, the name and 

address you can have a few thousand FOLDERS in the Cabinet because the 

size of each RECORD will be consequently "trimmed down". 

You can then use this Cabinet once a week or so to ADD NEW NAMES or to 

make address corrections, or to dump out the LABELS to your printer, but that's 

about it. No complex DOCUMENTS or LISTS. A "bare minimum" Cabinet used 

strictly for LABELS. 
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Folder Creation Dates 
Many people like to use Notes •n• Files by entering the DATE into a 

FIELD when creating the Folder. This records the time the Folder was entered 

into the Cabinet and from there you can use the DATE as a CONDITION in 

order to selectively choose just these Folders for new mailings. 

Target Mailing 
An advanced version of the MAILING HOUSE example would take into 

account your needs for printing CERTAIN LABELS instead of all of them at 

once. You can create a "Target Mailing" by generating an INDEX that will give 

you a LIST OF JUST THOSE FOLDERS FROM A SPECIFIC CITY, 

STATE OR ZIP CODE RANGE. 

Here's where you need to start thinking. Suppose you want to print LABELS 

for everyone in CALIFORNIA. This is very easy to do. You create an INDEX 

and use the "AND 11 CONDITION by entering the FORMULA "=CA" in the 
11Stat n 

e FIELD. This will generate a LIST OF ALL FOLDERS HAVING "CA" 

IN THAT FIELD. 

Or ·t 
CO ' 

1 
You wanted CALIFORNIA AND NEW YORK you could use the "OR" 

NDITIONS by entering the FORMULA ":CA,:NY" (the COMMA 

sep~ating multiple conditions). By using these CONDITIONS you can obtain 
partial spec· 1• • • "T 

' 1a •zed LISTS from your Cabinet and then pnnt a arget Mailing". 

PR:s another example, let's say you want to print LABELS for all the 

PRE:IDENTs of companies. But, how would you know if a person is the 

a "Mi ID~NT? Well, you can do this a few different ways. One example is to take . 

FOLDsc. FIELD and rename it to "Position" and when you create a NEW 

"PRE ER You simply type a "P" into the "Position" FIELD which will stand for 

SIDENT". 
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You would then create an INDEX by setting the "AND" CONDITION with an 

Exact Match "=P" FORMULA in the "Position" FIELD . This will scan your 

Drawer and build a LIST OF JUST THOSE FOLDERS having the letter "P" in 

that FIELD. You can then print your LABELS only for these PRESIDENTS . 

Form Letters 
Besides printing LABELS you may also wish to use Notes •n• Files to 

produce your FORM LETTERS. You can then employ the INDEX CONDI­

TIONS to generate the desired "Target Mailing". Furthermore, you can FLAG 

A FOLDER to always know who was mailed a LETTER and when. 

Dateline Tracking 
When printing LABELS or LETTERS you can set the "Flag Folder" option 

to record the fact. Then next week you can perform another mailing by printing 

some of the remaining FOLDERS NOT YET FLAGGED . This is done by 

entering the DATE you printed as a Does Not Equal CONDITION, you see , 

and ALL FOLDERS NOT HAVING THAT DATE will be selected for printing. 

In this way, you will eventua lly get around to printing every Folder, turning it 

around every month or so. Thus, you can keep track of your mailings and always 

know when to print the next batch. 

Call Back Example 
Let's look at what a salesperson might do in real life. He or she gets on the 

phone and talks to various clients and when a client is not in or says to "call back 

next week" , then it's Notes •n• Files to the rescue! 

When you call someone you open their FOLDER while on the phone. This 

allows you to enter any COMMENTS or to enter a "CALL BACK DATE" into 

one of the FIELDS . Then, next week you can generate an INDEX by coming up 

with a LIST of people you need to CALL BACK. You either enter a DATE or a 

CODE and then set the CONDITIONS accordingly to generate the LIST . 
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Using Sub jects 
"Business" type things are n.Q1 the only things you can do with Notes •n• 

Files . You can dedica te your Cabinets entirely to certain subjects. For example, 

you can create a Cabinet called "Poetry " and then create a FOLDER fo r each 

TOPIC you use in your POEMS . You could RE-NAME the "Name " FIELD to 

something like "Topic " and then instead of using a PERSON'S NAME you 

would type the actual SUBJECT TITLE into that FIELD . Your Folders will then 

by filed alphabetica lly BY THE ENTERED SUBJECT . 

The n, when you type and Save a DOCUMENT containi ng your lyrical 

prose, you FILE IT INTO ITS PROPER FOLDER , thereby "group i ng " 

similar POE MS togethe r. You cou ld eve n open up a Folder to its FOLDER 

LOG to see the LIST of your POEMS and from there either choose a POEM to 

work with, or print the LOG (as a WINDOW ) to obtain a LIST on paper. 

Using GraphicWr iter ™ 
By far the most fun app lica tion is to use another DataPak product ca lled 

"GraphicWr i ter ™" along with Notes •n• Files . As you may know, 

GraphicWriter TM is a prog ram for your GS that allows you to type and draw 

pictures right on the same page. 

You can use GraphicWriter ™ to create your LETTERHEAD stationery by 

draw ing your LOGO at the top of a Docume nt and PRINTING the Document 

out on a few sheets of paper. Then, you can feed the paper back into the printer, 

go into Notes •n• Files and crank out your fancy FORM LETTERS . 

Or, you can design your PROMOTIONAL FL YEAS and other page layouts 

inside GraphicWriter ™ and use Notes •n• Files for your MAILING LABELS 

and FORM LETTERS as well as employ ing the INDEX CONDITIONS fo r 

FLAGGED TARGET MAILINGS . 
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' .. .. ... ... 
Notes •n• Files will also accept a TEXT FILE from GraphicWriter Tht so ... 

you can actually transf er over the BODY of your GraphicWriter TM DOCU- ... 

MENTS directly into Notes •n• Files FOLDERS! .... ... 
Or, if you want, you can also send GraphicWriter ™ the TEXT CONTENTS ... 

of your Notes •n• Files DOCUMENTS. Then , wh ile inside Graphic- ... 

Writer ™ you could change the COLOR of the text or add DRAWINGS right on ... 

the pages , and so forth . ._ ... 
For more information concerning GraphicWriter ™, visit your local Apple ... 

Dealer and ask to see a demo, or better yet, give DataPak a call and ask about ... 

our latest product s for your Apple][ GS. We'd love to hear from you! ... 

~ .... ,... 
~ 
~ 
~ 
~ 
~ 
~ 
~ 
~ 
~ 
~ 
~ 
~ 
~ 
~ 
~ ,._ 
~ 
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Appendix A : Problems & Solutions 

Ther e may be times when you experience some "trouble" without readily 

coming up with the proper solution. Of course, when you tell Notes •n• Files to 

do something for you it can Q.O.]y obey your exact instructions. For example, if you 

order it to show you a LIST , but you mistakingly use the WRONG FIELD for a 

CONDITION, then Notes •n• Files has no choice but attempt to display your 

LIST anyway. This LIST, of course, isn't what you want , so you would have to 

go back and TRACE through all of the SETUP steps in order to locate the 

actual error and handle it. 

Below are some examples of the most common "problems" and their possible 

solutions: 

AREA: FOLDERS 
PROBLEM : Folders are filed in the Drawer incorrectly. 

SOLUTION: The data entered in the "Name" FIELD begin s with .an odd 

character (such as a SPACE) so a Folder is naturally filed before the "A's". 

PROBLEM: Folders appear as "blank cards" in the Drawer. 

SOLUTION : The Folders are probably correctly filed, but you are currently 

disp laying one of the 2 CUSTOM INDEXES that have NO DATA in the 

FIRST FIELD COLUMN (which is the one used for determining the filing ). 

PROBLEM: No Folders appea r at all! 

SOLUTION: You are either using something like "ZZZ" for a "Find Folder" . 

search string, or you are using an INDEX that · naturally shows no Folders. 

PROBLEM: A Folder is filed in the wrong Drawer. 

SOLUTION : Bring out the Folder, open the ~ Drawer and ope n the 

Folder to its SUMMARY , then Save it to perform the transfer. 



AREA: DOCUMENTS 
PROBLEM: A Document appears in the wrong Folder. 

SOLUTION : Since a Document is always Saved to the FRONTMOST 

FOLDER, the "wrong" Folder was "in front" at the time of saving. The remedy 

is to bring out the desired Folder and simply DRAG the Document over to this 

Folder and "drop" it in to perform the transfer. 

PROBLEM: Can't change FONTS on existing TEXT. 

SOLUTION: Simply HIGHLIGHT the desired selection of TEXT (press the 

mouse button and drag the pointer over it) and choose a different FONT , 

SIZE or STYLE from the menus . 

PROBLEM: "UnDo" never seems to be active. 

SOLUTION: "Undo" becomes active when you HIGHLIGHT some text and 

accidentally type a character or hit the backspace key or . Selecting "Undo" at 

this time will re-insert the TEXT that was removed. Note that if you have "Cut" 

out some text you can always "Paste" it back into the Document to "Undo " 
~e"Cut'! ~ 

PROBLEM: Changing a TAB doesn't change all the TEXT of the Document. 

SOLUTION: This is correct. Each PARAGRAPH is unique and a TAB 

always corresponds to the currently shown RULER. To change the rest of 

the TEXT you simply HIGHLIGHT the desired PARAGRAPHS so that 

changing the TAB will affect all of them (but Il..Q1 the PARAGRAPHS that 

aren't HIGHLIGHTED) . 

AREA: INDEX LISTS 
PROBLEM: The wrong Folders (or no Folders) appear on the List wind?w. 

SOLUTION: You are setting CONDITIONS that obviously can 't select 

the desired Folders, or you are choosing a combjnatjon of "ANDs" and "ORs" 

that prevents Folders from being selected. 
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A REA: PRINT ING 

PROBLE M: No FONTS appear when printing a Document. 

SOLUTION: You are printing in the DRAFT mode which wo rks like a 

typewrite r and cannot print any FONTS or STYLES . 

PROBLEM : The wrong Folders print during Labels or Letters . 

SOLUTION : The wrong INDEX has been chosen or the specified CONDI­

TIONS canno t se lect any Folders at al l. A lso, Q1Jk the CURRENTLY 

OPE NED DRAWER will be used for printing, unless BOTH DRAWERS 

ARE CLOSED in which case the ENTIRE CABINET will be used. 

PROBLEM : No MERGE takes place, and "{Name}" literally prints instead. 

SOLUTION: Th e FIELD TITLE is incor rectly spelled, or there is an 

added SPACE .af1fil the first BRACE and ~ the FIELD TITLE . 

PROBLEM: Just want to print one Letter, not 1 OO's. 

SOLUTION: Simp ly create the DOCUMENT and DRAG it "through " the 

COPIER. (If you want a single FORM LETTER then you must first br ing out 

the desired Folder from the Drawer). 

AREA: DISKS 
PROBLEM: Disk is running out of space for my Cabinet. 

SOLUTION : You need to obtain a second disk drive and use another disk 

dedicated to data only. 

PROBLEM : How do I make a copy of my Cabinet (or delete or rename it)? 

SOLUTION: By using your System Util it ies Disk . Howeve r, note that a 

Cabinet consists of 3 FILES (as explaine d earlier in the "New Cab inet " 

section of the manual) and all of them must be used for a proper copy. 



o to 9 69 
9 to O 69 
A to Z 69 
ABBREVIATIONS 24 
ABORT PRINTING 73 

INDEX 

ACROSS, LABELS DISTANCE 78 
ACROSS, NUMBER OF LABELS 77 
ACTIVATING FORMULAS 60 
ACTIVE FOLDER 37 
ADD LF AFTER CR 74 
ADDING FOLDERS TO INDEX 70 
ALIGNMENTS 47 
ALPHABETICAL ORDER 10,27,70 
"AND" & "OR" CONDITIONS 60,89 
"AND" CONDITIONS (LABELS) 77 
ANY OCCURRENCE 62 
AppleWorks™ 32,41 
APPLICATIONS 88 
ARROW KEYS 21 
ARROWS, DRA WEA 55 
ARROWS, FIELD SELECTION 68 
BACKSPACE KEY 21,45 
BLANK LINE 48,74 
BOOT-UP 4,5 
BRACES 80 
BREAK, PAGE 48 
CABINET, CLOSE 12 
CABINET, COPYING 17 
CABINET, NEW 12 
CABINET, NAMING A 17 
CABINET, OPENING A 16 
CABINET, PRINTING ENTIRE 76 
CALL BACK EXAMPLE 90 
CAN, TRASH 53 
CATEGORIES 65 
CENTER JUSTIFY 47 
CHANGES, SAVE 22 
CHANGING COLUMN WIDTHS 58 
CHANGING FIELDS 21 
CHARACTERS PER INCH 78 
CLICK, SHIFT (WORDS) 44 
CLIPBOARD 46 
CLOSE CABINET 12 
CLOSING A DOCUMENT 36 
CLOSING A DRAWER 10 
CLOSING FOLDER 30 
CLOSING FOLDER SUMMARY 22 
CLOSING STATIONERY WINDOW 19 

CODE, RANGE OF ZIP 64,89 
CODE, SORTING ZIP 69 
CODE, ZIP 64 
CODES, KEY 26 
COLOR TEXT (GraphicWriter n.1) 92 
COLUMN, ADDRESS SORT 69 
COLUMN, FIRST 67,70 
COLUMN, (none) 68 
COLUMN WIDTHS 58 
COMBINING FORMULAS 64 
COMMA, FROM & TO 81 
CONDITIONS 70,87 
CONDITIONS, ACTIVATING 60 
CONDITIONS, "AND" & "OR" 60 
CONDITIONS, COMBINING 64 
CONDITIONS, ENTERING 60 
CONDITIONS FORMULAS 62 
CONDITIONS, FORM LETTERS 84 
CONDITIONS, INDEX 70,87 
CONDITIONS, LABELS 77 
CONDIT IONS, PRINTING 61 
CONDITIONS , USING DATE 85,88 
CONTROL PANEL 4 ,69,74 
COPIER 71,78 
COPIES, PRINTING 73 
COPIES (FORM LETTERS) 84 
COPIES (LABELS) 79 
COPYING A CABINET 17 
COPYING DOCUMENTS 36,46 
COPYING TEXT 46 
CR, ADDING LF AFTER 74 
CREATING A DOCUMENT 34 
CREATING A FORM LETTER 80 
CREATING AN INDEX 67 
CREATING A NEW CABINET 12 
CREATING A NEW FOLDER 19 
CREATING MULTIPLE FOLDERS 27 
CREATION DATE 40 ,89 
CURRENTLY ACTIVE FOLDER 37 
CURSOR 21,42 
CUSTOM FIELDS 31 ,82 
CUSTOM LIST 60 
CUT 45 
CUT /COPY / PASTE 45 
CUTTING TEXT 45 
DAISY-WHEEL 3,72 
DATA BASES 32 
DATA DISK 2 
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DATA ENTRY 21,24 
DATE (FLAG) 85-86 
DATE AS A CONDITION 88 
DATE FORMAT 69 
DATE, CALL BACK EXAMPLE 90 
DATE, FOLDER CREATION 89 
DATE, WRITING BACK 85 
DATELINE TRACKING 90 
DEC TO JAN 69 
DEFAULTS, PRINTING 74 
DIFFERENT DISK 14 
DIMENSIONS, LABEL 78 
DISK 2,24 
DISK DRIVE 2,4,14 
DISK FOLDERS 13 
DISK , HARD 3,4 
DISK, STARTUP 4 
DISK , USING DIFFERENT 14 
DISKETTE, MASTER 5 
DISPLAY POSITION, FOLDER 56 
DISPLAY, SELECTING FOLDER 59 
DISPLAY , START AT 59 
DISTANCE ACROSS LABELS 78 
DISTANCE DOWN LABELS 78 
DOCUMENTS 34 
DOCUMENT, CLOSING 36 
DOCUMENT, COPY OF 36 
DOCUMENTS, COPY & PASTE 46 
DOCUMENT, CREATING A 34 
DOCUMENT DATE 40 
DOCUMENT, DOUBLE-SIZE 74 
DOCUMENT, FILING RULE 37 
DOCUMENT, FORM LETTER 80,90 
DOCUMENT FORMATTING 47 
DOCUMENT ICON 39 
DOCUMENT MARGINS 51 
DOCUMENT, MOVING 38 
DOCUMENT, NAMING 35 
DOCUMENT, ONE-SHOT LETTER 83 
DOCUMENT, OPENING 39,59 
DOCUMENT PRINTING 71,75,84 
DOCUMENT, PRINTING OPEN 75 
DOCUMENT, RECOVERING 53 
DOCUMENT, SAVE 35 
DOCUMENT, SAVE AS 36 
DOCUMENT, SAVE AS TEXT 41 
DOCUMENT, SAVE CHANGES 36 
DOCUMENT, SAVE TO STATIONERY 38 
DOCUMENT , SAVING FORM LETTER 82 
DOCUMENT, SHREDDING 53 

DOCUMENT THUMB 49 
DOCUMENTS, THUMBING FOR 39 
DOCUMENT , TRANSFERRING 38 
DOCUMENT , TRASHING 53 
DOCUMENT IN THE TRASH 54 
DOCUMENT , "Untitled " 34 
DOCUMENTS , SALUTATIONS IN 81 
DOG EARS 39 
DOUBLE SPACING 48 
DOUBLE-CLICK WORDS 44 
DOUBLE-SIZE DOCUMENTS 74 
DRAFT LABELS 78 
DRAFT QUALITY 72 
DRAWER ARROWS 55 
DRAWER , CLOSING A 10 
DRAWER, MOVING FOLDER TO 30 
DRAWER, OPENING A 9 
DRAWER , PRINT 76 
DRAWER, RENAMING A 10 
EDITING A FIELD 21 
EDITOR 42 
EMPTY FOLDER 19 
EMPTY INDEX 68 
EMPTY TRASH 53 
-END 73 
ENTERING DATA 21,24 
ENTERING FORMULAS 60 
ENTIRE CABINET PRINTING 76 
EQUALS UP TO 63 
EXACT MATCH 62 
EXAMPLE, CALL BACK 90 
EXAMPLE, "POSITION" 89 
EXAMPLE , PRESIDENTS 89 
EXPORTING TEXT 41,92 
FIELDS, CHANGING 21 
FIELDS, CUSTOM 82 
FIELDS, EDITING 21 
FIELDS, ENTERING DATA 21 
FIELDS, FLAG 85 
FIELDS, FOLDER 20 
FIELD , " LABELS" 85 
FIELD, "LETTERS" 85 
FIELDS, "MISC." 26 
FIELD, POSITION (EXAMPLE} 89 
FIELDS, RENAME 31 
FIELD SELECTION ARROWS 68 
FIELD SORT TYPES 68 
FIELD TITLES 31 
FILE CABINET 9 
FILE FOLDERS 18 



FILE MANAGEMENT 53 
FILE, TEXT 32,41,92 
FILES, IMPORT TEXT 32,92 
FILING DOCUMENTS 37 
FILING FOLDERS RULE 27 
FIND FOLDER 55 
FIRST COLUMN 67 
FIRST COLUMN OF INDEX 70 
FLAG FIELDS 85 
FLAG FOLDER 90 
FLAGGING A FOLDER 85,90 
FOLDERS 29 
FOLDERS, ADDING TO INDEX 70 
FOLDER , CREATING NEW 19 
FOLDERS, CREATING MULTIPLE 27 
FOLDER CREATION DATES 89 
FOLDER, CURRENTLY ACTIVE 37 
FOLDER TO DIFFERENT DRAWER 30 
FOLDERS {DISK) 13 
FOLDER DISPLAY POSITION 56 
FOLDER , EMPTY 19 
FOLDER FIELDS 20 
FOLDER FIELDS , CHANGING 21 
FOLDER FIELD , EDITING 21 
FOLDER FIELDS , ENTERING DATA 21 
FOLDER FIELDS {FORM LETTERS) 80 
FOLDER FIELDS, MERGING 82 
FOLDER FIELDS , MISC . 26 
FOLDER FIELD TITLES 31,80 
FOLDER, FINDING 55 
FOLDER FLAGS 90 
FOLDER, FLAGGING A 85 
FOLDER , FRONTMOST 37 
FOLDER, GETTING A 29 
FOLDER, LAST USED 37 
FOLDER LOG 20,40 
FOLDER , MOVING 29 
FOLDER, NEW 23 
FOLDER, OPENING 30 ,59 
FOLDER, POSITION EXAMPLE 89 
FOLDER, PUTTING AWAY 30 
FOLDERS, QUANTITY OF 18,24 
FOLDER, RENAME FIELDS 31 
FOLDER, SAVE 22,30 
FOLDERS, SAVE & NEW 27 
FOLDER SAVE RULE 24 
FOLDERS, SEARCHING 55 
FOLDERS, SELECTING LABELS 76 
FOLDER , SHIFT KEY 30 
FOLDER SUMMARY 20 

FOLDER SUMMARY, CLOSING 22 
FOLDER, TRANSFERRING 30 
FOLDER, TRASHING 54 
FONTS 43,74 
FONTS, PRINTING 3,72 
FONTS , REDUCING 74 
FORM LETTERS 25,80,90 
FORM LETTERS , FLAG FOLDER 85 
FORM LETTER, FOLDER FIELDS 80 
FORM LETTERS INDEX 84 
FORM LETTER , ONE-SHOT 83 
FORM LETTERS, PRINTING 84 
FORM LETTER, REVERSE NAME 81 
FORM LETTERS , SALUTATIONS 81 
FORM LETTER, SAVING 82 
FORMAT , DATE 69 
FORMAT , LABEL 77 
FORMATTING A DOCUMENT 47 
FORMULAS, ACTIVATING 60 
FORMULAS, COMBINING 64 
FORMULAS, CONDITIONS 62 
FORMULAS, ENTERING 60 
FROM COMMA ON 81 
FRONTMOST FOLDER 37 
FULL JUSTIFY 48 
GENERATING AN INDEX 70 
GETTING A FOLDER 29 
GraphicWriter n.t 91 
GREATER OR LESSER THAN 63 
HIGH QUALITY 72 
HIGHLIGHTING TEXT 43 
I- BEAM POINTER 42 
ICON {DEFINITION) 18 
ICON, DOCUMENT 39 
IMAGEWRITER 3 ,72,74 
IMPORTING AppleWorks rn 32,41 
IMPORTING DATA BASES 32 
IMPORTING TEXT 32,41 ,92 
INDENTATION, PARAGRAPH 51 
INDEXES 65 
INDEX, ADDING FOLDERS TO 70 
INDEX, ALPHABETICAL ORDER 70 
INDEX, COLUMN WIDTHS 58 
INDEX, COMBINING FORMULAS 64 
INDEX CONDITIONS 70 ,88 
INDEX, CREATING AN 67 
INDEX, CUSTOM 60 
INDEX, EMPTY 68 
INDEX , ENTERING FORMULAS 60 
INDEX , FIRST COLUMN 67 ,70 
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INDEX (FORM LETTERS) 84 
INDEX , FORMULAS 62 
INDEX, GENERATING AN 70 
INDEX LIST 66 ,87 
INDEX, PRINTING 87 
INDEX, SELECTING A FIELD 67 
INDEX , SELECTING AN 65 
INDEX, SELECTING FOLDER FROM 59 
INDEX SETUP 67 ,87 
INDEX, START DISPLAY AT 59 
INSTALL HARD DISK 4 
JAN TO DEC, DEC TO JAN 69 
JUSTIFY 47 
KEY CODES 26 
KEY , ARROW 21 
KEY, BACKSPACE 21 ,45 
KEY, SH IFT (FOLDER) 30 
KEY , TAB 21 
LA B ELS 3,25 ,76, 88 ,9 1 
LABE LS ACROSS 77 
LABELS CONDITIONS 77 
LABEL DIMENSIONS 78 
LABELS, DISTANCE ACROSS 78 
LABELS, DISTANCE DOWN 78 
LABELS, DRAFT PRINTING 78 
" LABELS" FIELD 85 
LABELS, FLAGGING FOLDER 85 
LABEL FORMAT 77 
LABELS, LEFT MARGIN 79 
LABELS PRINTOUT 79 
LABELS, REVERSING NAME 77 
LABEL ROW 77 
LABELS, SELECTING FOLDERS 76 
LABEL STOCK 78 
LABELS, TRIAL PRINT 78 
LASERWRITER 3,72 
LAST NAME 28 
LAST USED FOLDER 37 
LAUNCHER , PROGRAM 4,5 
LEFT JUSTIFY 47 
LEFT & RIGHT MARGINS 51 
LEFT MARGIN (FORM LETTERS) 84 
LEFT MARGIN (LABELS) 79 
LEFT MARGIN (PRINTING) 73 
LEFT TAB 52 
LESS OR GREATER THAN 63 
LETTERHEAD (GraphicWriter T") 91 
LETTERS 25,80,90 
"LETTERS" FIELD 85 
LETTERS , FORM 80,90 

LETTERS, LEFT MARGIN 84 
LETTER, ONE -SHOT 83 
LETTERS, PRINTING 84 
LETTERS , REVERSE NAME ON 81 
LETTERS , SAVING 82 
LETTERS, SALUTATIONS ON 81 
LIMITATIONS, PAGE 48 
LINE, BLANK 48 ,74 
LINE-FEED, ADDING 74 
LINES PER INCH 78 
LIST WINDOW , INDEX 66 
LIST, CUSTOM 60 
LIST, GENERATING A 70 
LIST , MASTER 57 
LISTS, PRINTING 87 
LIST, SCROLLING 58 
LIST, SELECTING A FIELD 67 
LIST , SELECTING FOLDER ON 59 
LIST, START DISPLAY AT 59 
LOG 20,40 
MAIL HOUSE 88 
MAIL MERGE 25 ,80 
MAILING LABELS 3,25,76,88 ,91 
MAILING, TARGET 89,90 
MAIN SCREEN 3,4,7 
MANAGEMENT, FILE 53 
MARGINS (DOCUMENT) 51 
MARGIN (LABELS) 79 
MARGIN (PRINTING) 73 
MARK, INDENTATION 52 
MARKS, TAB 52 
MASTER FORM LETTER 80 
MASTER LIST 57 
MATCH , EXACT 62 
MEMORY 2,4 
MENUS 8 
MERGE 25 
MERGING FOLDER DATA 80,82 
MISC . FIELDS 26 
MOVING A FOLDER 29 
MOVING DOCUMENTS 38 
MOVING STATIONERY WINDOW 19 
MULTIPLE CONDIT IONS 64 
MULTIPLE FOLDERS 27 
NAME, LAST 28 
NAME , REVERSING 28,77,81 
NAME, REVERSE (LETTERS) 81 
NAME, REVERSE (LABELS) 77 
NAMING A CABINET 15,17 
NAMING A DOCUMENT 35 



NAMING A DRAWER 10 
NAMING FOLDER FIELDS 31 
NAMES , FIELD 31 
NEW CABINET 12 
NEW FOLDER 19,23 ,27 
(none) COLUMN 68 
NOT EQUAL 64 
NUMBER OF LABELS ACROSS 77 
NUMBERS, PAGE 48 ,72,84 
OCCURRENCE, ANY 62 
ONE-SHOT FORM LETTER 83 
OPEN DOCUMENT PAINTING 75 
OPENING A CABINET 16 
OPENING A DOCUMENT 39,59 
OPENING A DRAWER 9 
OPENING A FOLDER 30,59 
"OR" CONDITIONS 60,77 ,89 
"OR" CONDITIONS (LABELS) 77 
ORDER, ALPHABETICAL 10,27,70 
PAGES 48 
PAGE BREAK 48 
PAGE LIMITATIONS 48 
PAGE NUMBERS 48,72 ,84 
PAGE RANGE 73 
PAPER, PRINTER 3 
PARAGRAPH INDENTATION 51 
PARAGRAPHS 50 
PASTING TEXT 46 
PICTURES (GRAPHICWRITER TM) 91 
PLAIN TEXT 44 
POINT SIZE 43 
POINTER 5 
POINTER, I-BEAM 42 
PORT, PRINTER 74 
"POSITION" FIELD EXAMPLE 89 
POSITION, FOLDER DISPLAY 56 
PRESIDENTS EXAMPLE 89 
PRINTER PAPER 3 
PRINTER PORT 74 
PRINTERS 3 ,72 
PRINTING 71 
PRINTING DEFAULTS 74 
PRINTING DOCUMENTS 71,75 
PRINTING , DRAFT LABELS 78 
PRINTING A DRAWER 76 
PRINTING ENTIRE CABINET 76 
PRINTING FORM LETTERS 84 
PRINTING LISTS 87 
PRINTING OPEN DOCUMENT 75 
PRINTING QUALITY 72 

PRINT RANGE 73 
PRINTING REDUCTION 74 
PRINTING , START 73 
PRINTING , STOP 73 
PRINTING TECH INFO 74 
PRINTING , TEST 78 
PRINTING USING CONDITIONS 61 
PRINTING WINDOWS 75 
PROGRAM LAUNCHER 4,5 
PROGRAM , QUITTING 17 
PUTTING FOLDER AWAY 30 
QUALITY 72 
QUANTITY OF FOLDERS 18 ,24 
QUITTING PROGRAM 17 
RAM 4 
RANGE, PAGE 73 
RANGE (FORM LETTERS) 84 
RANGE , ZIP CODE 64,89 
RECORDS 24 ,88 
RECOVERING DOCUMENTS 53 
REDUCING FONTS 74 
REMOVING TABS 52 
REMOVING TEXT 45 
RENAME DRAWER 10 
RENAME FOLDER FIELDS 31 
REOPENING DOCUMENT 39 
REVERSING NAME 28 
REVERSE NAME (LETTERS) 81 
REVERSE NAME (LABELS) 77 
RIGHT JUSTIFY 47 
RULE , FOLDER FILING 24 ,27 
RULER SETTINGS 50 
SALUTATIONS 81 
SAMPLE .FILES 9 
SAVE & NEW 27 
SAVE AS TEXT 41 
SAVE CHANGES (DOCUMENT) 36 
SAVE CHANGES (FOLDER) 22 
SAVE DOCUMENT 35 
SAVE DOCUMENT AS .. 36 
SAVE FOLDER 22,30 
SAVE FOLDER RULE 24 
SAVING A FORM LETTER 82 
SAVING TO STATIONERY 38 
SCREEN (PRINTING vs) 74 
SCROLL BARS 49 
SCROLLING A LIST 58 
SCROLL BAR (LOG) 40 
SCROLL BAR (TRASH) 54 
SEARCHING FOR FOLDERS 55 



SELECTING A FIELD 67 
SELECTING FOLDERS FOR LABELS 76 
SELECTING AN INDEX 65 
SET LEFT TAB 52 
SETTING A FLAG 85 
SETTINGS , RULER 50 
SETUP BUTTON 67 
SETUP INDEX 67,87 
SHIFT KEY (FOLDER) . 30 
SHIFT-CLICK 44 
SHIFT-TAB 21 
SHREDDING DOCUMENTS 53 
SINGLE & DOUBLE SPACING 48 
SINGLE SHEET 73,84 
SIZES, POINT 43 
SORT ADDRESS COLUMN 69 
SORT FIELD TYPES 68 
SORT BY ZIP CODES 69 
SPACING , SINGE & DOUBLE 48 
SPECIAL APPLICATIONS 88 
ST AND ARD QUALITY 72 
ST ART DISPLAY AT 59 
START PRINTING 73 
STARTUP DISK 4 
STATIONERY WINDOW 18 
STATIONERY WINDOW, CLOSING 19 
STATIONERY WINDOW , MOVING 19 
STATIONERY, SAVE DOCUMENT TO 38 
STOCK '(LABELS) 78 
STOP PRINTING 73 
STYLE 44 . 
STYLES, PRINTING 72 
SUBJECTS, USING 28,91 
SUMMARY, CLOSING 22 
SUMMARY , FOLDER 20 
TAB KEY 21 
TAB, SET LEFT 52 
TAB, SHIFT 21 
TABS , REMOVING 52 
TARGET MAILING 89,90 
TEXT FILES 32 ,92 
TEXT , COLOR (GraphicWriter T"' ) 92 

TEXT, COPYING 46 
TEXT, CUTTING 45 
TEXT, HIGHLIGHTING 43 ,44 
TEXT, IMPORTING & EXPORTING 41 

TEXT, JUSTIFYING 47 
TEXT, PASTING 46 
TEXT, PLAIN 44 
TEXT, REMOVING 45 

TEXT , SAVE AS 41 
TEXT, STYLES 44 
THROWING AWAY DOCUMENT 53 
THROWING AWAY FOLDERS 54 
THUMB (DOCUMENTS) 49 
THUMBING FOR DOCUMENTS 39 
TITLE , DOCUMENT 35 
TITLE , DRAWER 10 
TITLES , FOLDER FIELD 31,80 
TO THE COMMA 81 
TRACKING DATE 90 
TRANSFERRING A DOCUMENT 38 
TRASH CAN 53 
TRASH SCROLL BAR 54 
TRASH, DOCUMENT IN 54 
TRASHING A FOLDER 54 
TRASHING DOCUMENT 53 
TRIAL PRINT 78 
TYPES , FIELD SORT 68 
"Untitled" DOCUMENT 3_4 
UPDATING A FOLDER 85 
VERSION NUMBER 8 
WIDTHS , COLUMN 58 
WINDOW, COLUMN WIDTHS 58 
WINDOW , FOLDERS ON 59 
WINDOW, MOVING 19 
WINDOW, PRINTING 75 
WINDOW , STATIONERY 18 
WINDOW THUMB 49 
WORD WRAP 51,82 
WORDS , DOUBLE-CLICK 44 
WRITING BACK DATE 85 
Z TO A 69 
ZIP CODE · RANGE 64,89 
ZIP CODE SORT 69 



Notes •n• Files™ Keyboard Chart 

File: Stgle: ~ 

16 sl Save Folder 16 Tl Plain Text E 16 nl Save & new Folder 16 Bl Bold 

16 s! Save Document 16 I I Italic ~ 
16 Fl Find Folder l6u! Underline .. .... 
16 ol Quit ~ 9 Point .. 

16 21 
... 

Edit: 12 Point ... 
!6 zj Undo lo 31 18 Point ... 
l6x! .. 

Cut Format : ... 
16 cl Copy 16 JI Left Justify ... ... 16 vi Paste l6H! Full Justify ... 
16 RI Rename Folder Fields 16 LI Set Left Tab 

... ... 
16 Dj Rename Drawer Print : .. 

lo Pl 
... 

Print Document .. 
low! Print Window ... ..... -.. ---.. 
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